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1. Bienvenue dans l'aide de COPA-DATA 

AIDE GÉNÉRALE 

Si vous ne trouvez pas certaines informations dans ce chapitre de l'aide, ou si vous souhaitez nous 
suggérer d'intégrer un complément d'information, veuillez nous contacter par e-mail : 
documentation@copadata.com (mailto:documentation@copadata.com). 

 

 

ASSISTANCE PROJET 

Si vous vous rendez compte que vous avez besoin de licences ou de modules supplémentaires, 
veuillezcontacter l'équipe commerciale par e-mail : support@copadata.com 
(mailto:support@copadata.com) 

 

 

LICENCES ET MODULES 

Si vous vous rendez compte que vous avez besoin de licences ou de modules supplémentaires, 
veuillezcontacter l'équipe commerciale par e-mail : E-mail  sales@copadata.com 
(mailto:sales@copadata.com). 
 

2. Contrôles 

Dans zenon, vous pouvez intégrer vos propres contrôles. Pour cela, les possibilités suivantes sont 
disponibles : 

 Contrôles utilisateur .NET (à la page 46) (pour la mise en œuvre dans zenon, voir également la 
section Contrôles .NET dans le manuel Synoptiques.) 

 ActiveX (à la page 12) (pour la mise en œuvre dans zenon, voir également la section ActiveX dans 
le manuel Synoptiques.)  

 WPF  (à la page 79) 

mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com
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  Informations 

Des informations concernant l'utilisation des interfaces de programmation (PCE, VBA, 
VSTA) de zenon sont disponibles dans le manuel Interfaces de programmation. 

  

  Informations concernant la licence 

Composante de la licence standard d’Editor et du Runtime. 

  

  Attention 

Notez que les erreurs dans les applications telles que ActiveX, PCE, VBA, VSTA, WPF 
et les applications externes accédant à zenon via l'API peuvent également influencer 
la stabilité du Runtime.  

 
 

3. Général 

Les contrôles de zenon peuvent être mis en œuvre via ActiveX, .NET et WPF. Via VBA/VSTA, vous pouvez 
accéder à l'API de zenon.  
 

3.1 Access zenon API 

Dans zenon, vous pouvez améliorer un contrôle ActiveX avec des fonctions spéciales, afin d'accéder à 
l'API zenon.  

ACCÉDEZ À L'API ZENON. 

 Dans Références du projet, sélectionnez Ajouter des références.... Bibliothèque d'objets de 

Runtime de zenon 

 Ajoutez les fonctions améliorées au code de classe du contrôle.  

FONCTIONS ACTIVEX AMÉLIORÉES DE ZENON 

// Appelé durant l'initialisation du contrôle dans le Runtime zenon. 
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public bool zenon>Init(zenon.Element dispElement)…  

// Appelé durant la destruction du contrôle dans le Runtime zenon. 

public bool zenonExit() 

// Prend en charge la liaison de variable du contrôle 

public short CanUseVariables()… 

// Le contrôle COM prend en charge différents types de données.  

public short VariableTypes()… 

// Nombre maximal de variables pouvant être liées au contrôle. 

public short MaxVariables()… 

EXEMPLE 

L'objet COM d'une variable de zenon est temporairement enregistré dans un membre, afin qu'il soit 
accessible ultérieurement via l'événement Paint du contrôle. 

zenon.Variable m_cVal = null; 

    public bool zenon>Init(zenon.Element dispElement) 

    { 

      if (dispElement.CountVariable > 0) { 

        try { 

          m_cVal = dispElement.ItemVariable(0); 

          if (m_cVal != null) { 

            object obRead = m_cVal.get_Value((object)-1); 

            UserText = obRead.ToString(); 

          } 

        }catch { } 

      } 

      return true; 

    } 

    public bool zenonExit() 

    { 

      try { 

        if (m_cVal != null) { 

          System.Runtime.InteropServices.Marshal.FinalReleaseComObject(m_cVal); 

          m_cVal = null; 

        } 

      } 

      catch { } 

      return true; 

    } 
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    public short CanUseVariables() 

    { 

      return 1; // les variables sont prises en charge 

    } 

 

    public short VariableTypes() 

    { 

      return short.MaxValue; // Tous les types de données sont pris en charge 

    } 

 

    public short MaxVariables() 

    { 

      return 1; // Au maximum, une variable sera liée au contrôle 

    } 

 

    private void SamplesControl_Paint(object sender, PaintEventArgs e) 

    { 

      // Les variables de zenon ont été modifiées 

      try { 

        if (m_cVal != null) { 

          object obRead = m_cVal.get_Value((object)-1); 

          UserText = obRead.ToString(); 

        } 

      }catch { } 

    }  
 

3.2 Méthodes 

Les contrôles ActiveX et .NET utilisant des variables de zenon nécessitent certaines méthodes 
spécifiques.   
 

3.2.1 CanUseVariables 

Prototype : short CanUseVariables();  

Cette méthode renvoie 1 ou 0 
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Vale
ur 

Description 

1 : Le contrôle peut utiliser des variables de zenon. 

Pour l'élément dynamique (via le bouton Variable), vous pouvez uniquement déclarer des variables 
de zenon avec le type déclaré par le biais de la méthode VariableTypes (à la page 10), 
conformément au nombre défini par la méthode  MaxVariables (à la page 10). 

0 : Le contrôle ne peut pas utiliser de variables de zenon, ou ne dispose pas de la méthode adéquate. 

Vous pouvez déclarer des variables de tout type, sans limitation de nombre. Dans le Runtime, 
toutefois, ces variables sont uniquement utilisables avec du code VBA. 

 
 

3.2.2 MaxVariables 

Prototype : short MaxVariables();  

Dans cette section est défini le nombre de variables pouvant être sélectionnées dans la liste de 
variables.  

Si la valeur 1 est renvoyée, la sélection multiple est désactivée dans la liste de variables. Un 
avertissement est alors affiché si plusieurs variables sont sélectionnées. 
 

3.2.3 Types de variables 

Prototype : short VariableTypes();  

La valeur renvoyée par cette méthode est utilisée comme masque pour les types de variable utilisables 
dans la liste de variables. La valeur est une relation AND (et) parmi les valeurs suivantes (définies dans 
zenon32/dy_type.h) : 
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Valeur 1 Valeur 2 Équivalent 

WORD 0x0001 Position 0 

BYTE 0x0002 Position 1 

BIT 0x0004 Position 2 

DWORD 0x0008 Position 3 

FLOAT 0x0010 Position 4 

DFLOAT 0x0020 Position 5 

STRING 0x0040 Position 6 

IN_OUTPUT 0x8000 Position 15 

 
 

3.2.4 zenonExit 

Prototype : boolean zenonExit();  

Cette méthode est appelée par le Runtime de zenon lorsque le contrôle ActiveX est fermé.  

Ici, tous les pointeurs de répartition renvoyant à des variables doivent être libérés. 
 

3.2.5 zenonExitEd 

Équivalent à zenonExit (à la page 11) ; exécuté lors de la fermeture d'ActiveX dans Editor.  

Cette méthode permet de réagir aux changements dans ActiveX, par exemple aux modifications de 
valeurs dans Editor. 

Information : actuellement uniquement disponible pour ActiveX.  
 

3.2.6 zenonInit 

Prototype : boolean zenonInit(IDispatch*dispElement);  

Cette méthode (dans le Runtime) permet au contrôle ActiveX d'obtenir un pointeur vers l'interface de 
répartition de l'élément dynamique. Ce pointeur permet également d'accéder aux variables de zenon 
liées à l'élément dynamique. 

Vous définissez l'ordre de tri des variables transférées dans la configuration de l'élément ActiveX à l'aide 
des boutons Bas ou Haut.  
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La boîte de dialogue Entrer les propriétés apparaît lorsque vous double-cliquez sur l'élément ActiveX ou 
que vous sélectionnez la propriété Paramètres ActiveX dans les propriétés de l'élément, dans le nœud 
Affichage. 
 

3.2.7 zenonInitEd 

Équivalent à zenonInit (à la page 11) ; exécuté lors de l'ouverture d'ActiveX dans Editor (double-cliquez 
sur le contrôle ActiveX). 

Information : actuellement uniquement disponible pour ActiveX. 
 

4. ActiveX 

ActiveX permet d'améliorer de manière autonome les fonctionnalités du Runtime et d'Editor de zenon.  

Dans ce manuel, vous trouverez des informations concernant : 

 Développement d'éléments ActiveX (à la page 12) 

 Exemple : LatchedSwitch (C++) (à la page 15) 

 Exemple : CD SliderCtrl (C++) (à la page 25) 

 Exemple : contrôle. NET exécuté en tant que contrôle ActiveX (C#) (à la page 32) 

Vous trouverez d'autres informations concernant les éléments dynamiques ActiveX dans le manuel 
Synoptiques, au chapitre ActiveX. 

ACTIVEX POUR WINDOWS CE 

Si un contrôle ActiveX Control doit être exécuté sous Windows CE, le modèle de cloisonnement 
(apartment) doit être défini sur Threading (Thread) cloisonné. S'il est défini sur Free (Libre), le 
contrôle ne s'exécutera pas dans le Runtime de zenon. 
 

4.1 Développement d'éléments ActiveX 

L'élément dynamique ActiveX dans zenon peut transmettre des variables au contrôle ActiveX sans 
utiliser VBA pour actionner le contrôle. 

Le contrôle définit maintenant automatiquement combien de variables zenon il peut utiliser et de quel 
type ces variables peuvent être. The properties of the control can be established by means of dynamic 
elements. 
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Pour cela, l'interface (interface de transmission) du contrôle doit être compatible avec un certain 
nombre de méthodes (à la page 13) .  
 

4.1.1 Méthodes 

Chaque contrôle ActiveX pouvant utiliser des variables de zenon doit contenir les méthodes suivantes :  

 CanUseVariables (à la page 9)  

 MaxVariables (à la page 10) 

 Types de variables (à la page 10) 

 zenonExit (à la page 11) 

 zenonExitEd (à la page 11) 

 zenonInit (à la page 11) 

 zenonInitEd (à la page 12) 

L'ID de répartition des méthodes dans l'interface est sans importance. Lors de l'appel des méthodes, 
zenon reçoit l'ID de l'interface.  
 

CanUseVariables 

Prototype : short CanUseVariables();  

Cette méthode renvoie 1 ou 0 

Vale
ur 

Description 

1 : Le contrôle peut utiliser des variables de zenon. 

Pour l'élément dynamique (via le bouton Variable), vous pouvez uniquement déclarer des variables 
de zenon avec le type déclaré par le biais de la méthode VariableTypes (à la page 10), 
conformément au nombre défini par la méthode  MaxVariables (à la page 10). 

0 : Le contrôle ne peut pas utiliser de variables de zenon, ou ne dispose pas de la méthode adéquate. 

Vous pouvez déclarer des variables de tout type, sans limitation de nombre. Dans le Runtime, 
toutefois, ces variables sont uniquement utilisables avec du code VBA. 

 
 

MaxVariables 

Prototype : short MaxVariables();  
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Dans cette section est défini le nombre de variables pouvant être sélectionnées dans la liste de 
variables.  

Si la valeur 1 est renvoyée, la sélection multiple est désactivée dans la liste de variables. Un 
avertissement est alors affiché si plusieurs variables sont sélectionnées. 
 

Types de variables 

Prototype : short VariableTypes();  

La valeur renvoyée par cette méthode est utilisée comme masque pour les types de variable utilisables 
dans la liste de variables. La valeur est une relation AND (et) parmi les valeurs suivantes (définies dans 
zenon32/dy_type.h) : 

Valeur 1 Valeur 2 Équivalent 

WORD 0x0001 Position 0 

BYTE 0x0002 Position 1 

BIT 0x0004 Position 2 

DWORD 0x0008 Position 3 

FLOAT 0x0010 Position 4 

DFLOAT 0x0020 Position 5 

STRING 0x0040 Position 6 

IN_OUTPUT 0x8000 Position 15 

 
 

zenonExit 

Prototype : boolean zenonExit();  

Cette méthode est appelée par le Runtime de zenon lorsque le contrôle ActiveX est fermé.  

Ici, tous les pointeurs de répartition renvoyant à des variables doivent être libérés. 
 

zenonExitEd 

Équivalent à zenonExit (à la page 11) ; exécuté lors de la fermeture d'ActiveX dans Editor.  

Cette méthode permet de réagir aux changements dans ActiveX, par exemple aux modifications de 
valeurs dans Editor. 

Information : actuellement uniquement disponible pour ActiveX.  
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zenonInit 

Prototype : boolean zenonInit(IDispatch*dispElement);  

Cette méthode (dans le Runtime) permet au contrôle ActiveX d'obtenir un pointeur vers l'interface de 
répartition de l'élément dynamique. Ce pointeur permet également d'accéder aux variables de zenon 
liées à l'élément dynamique. 

Vous définissez l'ordre de tri des variables transférées dans la configuration de l'élément ActiveX à l'aide 
des boutons Bas ou Haut.  
La boîte de dialogue Entrer les propriétés apparaît lorsque vous double-cliquez sur l'élément ActiveX ou 
que vous sélectionnez la propriété Paramètres ActiveX dans les propriétés de l'élément, dans le nœud 
Affichage. 
 

zenonInitEd 

Équivalent à zenonInit (à la page 11) ; exécuté lors de l'ouverture d'ActiveX dans Editor (double-cliquez 
sur le contrôle ActiveX). 

Information : actuellement uniquement disponible pour ActiveX. 
 

4.2 Exemple : LatchedSwitch (C++) 

L'exemple suivant décrit un contrôle ActiveX exécutant un verrouillage d'interrupteur avec deux 
variables de bit. La première variable représente l'interrupteur et la deuxième, le verrou. La valeur de la 
variable de commutation du contrôle ActiveX peut uniquement être modifiée si la variable de 
verrouillage possède la valeur 0. 

L'état de l'élément est représenté par quatre fichiers bitmap pouvant être sélectionnés dans la boîte de 
dialogue de propriétés du contrôle, dans zenon Editor. 
 

4.2.1 Interface 

Le contrôle LatchedSwitch comporte l'interface de répartition suivante : 

[ uuid(EB207159-D7C9-11D3-B019-080009FBEAA2),  

helpstring(Dispatch interface for LatchedSwitch Control), hidden ]  

dispinterface _DLatchedSwitch 

{  

         properties:  

         // NOTE - ClassWizard conserve les informations de méthodes ici.  

         // Soyez très prudent si vous modifiez cette section !  

         //{{AFX_ODL_PROP(CLatchedSwitchCtrl)  
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         [id(1)] boolean SollwertDirekt; 

         [id(2)] IPictureDisp* SwitchOn; // conteneur pour bitmaps  

         [id(3)] IPictureDisp* SwitchOff;  

         [id(4)] IPictureDisp* LatchedOn;  

         [id(5)] IPictureDisp* LatchedOff;  

         //}}AFX_ODL_PROP 

 

methods:  

// NOTE - ClassWizard conserve les informations de méthodes ici.  

 // Soyez très prudent si vous modifiez cette section !  

//{{AFX_ODL_METHOD(CLatchedSwitchCtrl)  

//}}AFX_ODL_METHOD  

[id(6)] short CanUseVariables();  

[id(7)] short VariableTypes();  

[id(8)] short MaxVariables();  

[id(9)] boolean zenonInit(IDispatch* dispElement);  

[id(10)] boolean zenonExit();  

[id(DISPID_ABOUTBOX)] void AboutBox(); 

}; 

Les propriétés SwitchOn à LatchedOff contiennent les fichiers bitmap correspondant aux quatre 
différents états du contrôle. Les fichiers bitmap sont conservés dans des objets de la classe 
CScreenHolder. La propriété SollwertDirekt définit si la saisie de valeurs prescrites doit être effectuée 
dans une boîte de dialogue, ou directement en cliquant sur le contrôle. 
 

4.2.2 Contrôle 

La mise en œuvre du contrôle s'effectue par le biais de la classe CLatchedSwitchCtrl. Les membres de 
cette classe sont les objetsCScreenHolder destinés au stockage de bitmaps. En outre, trois drivers de 
répartition sont générés pour l'élément dynamique et les variables : 

class CLatchedSwitchCtrl : public COleControl 

{ 

 

DECLARE_DYNCREATE(CLatchedSwitchCtrl) 

  

// Constructeur 

public: 

 

CLatchedSwitchCtrl(); 

  

// Substitutions 

 



ActiveX 

 

 

17 

 

 

// Substitutions de fonctions virtuelles générées par ClassWizard 

//{{AFX_VIRTUAL(CLatchedSwitchCtrl) 

public: 

virtual void OnDraw (CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid); 

virtual void DoPropExchange (CPropExchange* pPX); 

virtual void OnResetState (); 

virtual DWORD GetControlFlags(); 

//}}AFX_VIRTUAL 

  

// Mise en œuvre 

protected: 

 

~CLatchedSwitchCtrl(); 

  

DECLARE_OLECREATE_EX(CLatchedSwitchCtrl)    // Fabrique de classe et guid 

DECLARE_OLETYPELIB(CLatchedSwitchCtrl)      // GetTypeInfo 

DECLARE_PROPPAGEIDS (CLatchedSwitchCtrl)     // ID de page de propriété 

DECLARE_OLECTLTYPE (CLatchedSwitchCtrl) // Nom de type et informations d'état diverses 

  

// Tables de messages 

 

//{{AFX_MSG(CLatchedSwitchCtrl) 

afx_msg void OnLButtonDown(UINT nFlags, CPoint point); 

//}}AFX_MSG 

DECLARE_MESSAGE_MAP() 

  

// Tables de répartition 

 

//{{AFX_DISPATCH(CLatchedSwitchCtrl) 

BOOL m_sollwertDirekt; 

afx_msg void OnSollwertDirektChanged(); 

afx_msg LPPICTUREDISP GetSwitchOn(); 

afx_msg void SetSwitchOn(LPPICTUREDISP newValue); 

afx_msg LPPICTUREDISP GetSwitchOff(); 

afx_msg void SetSwitchOff(LPPICTUREDISP newValue); 

afx_msg LPPICTUREDISP GetLatchedOn(); 

afx_msg void SetLatchedOn(LPPICTUREDISP newValue); 

afx_msg LPPICTUREDISP GetLatchedOff(); 

afx_msg void SetLatchedOff(LPPICTUREDISP newValue); 
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afx_msg short CanUseVariables(); 

afx_msg short VariableTypes(); 

afx_msg short MaxVariables(); 

afx_msg BOOL zenonInit(LPDISPATCH dispElement); 

afx_msg BOOL zenonExit(); 

//}}AFX_DISPATCH 

CScreenHolder m_SwitchOn; 

CScreenHolder m_SwitchOff; 

CScreenHolder m_LatchedOn; 

CScreenHolder m_LatchedOff; 

  

 

DECLARE_DISPATCH_MAP() 

  

afx_msg void AboutBox(); 

  

// Event maps 

 

//{{AFX_EVENT(CLatchedSwitchCtrl) 

//}}AFX_EVENT 

DECLARE_EVENT_MAP() 

  

  double VariantToDouble(const VARIANT FAR *v); 

  void VariantToCString(CString *c,const VARIANT FAR *v); 

  BOOL IsVariantString(const VARIANT FAR *v); 

  BOOL IsVariantValue(const VARIANT FAR *v); 

  

// ID de répartition et d'événement 

public: 

 

CString szVariable[2]; 

IElement m_dElement; 

IVariable m_dLatchVar, m_dSwitchVar; 

  

 

enum { 

//{{AFX_DISP_ID(CLatchedSwitchCtrl) 

dispidSollwertDirekt = 1L, 

dispidSwitchOn = 2L, 
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dispidSwitchOff = 3L, 

dispidLatchedOn = 4L, 

dispidLatchedOff = 5L, 

dispidCanUseVariables = 6L, 

dispidVariableTypes = 7L, 

dispidMaxVariables = 8L, 

dispidZenOnInit = 9L, 

dispidZenOnExit = 10L, 

//}}AFX_DISP_ID 

}; 

}; 
 

4.2.3 Méthodes 

Les méthodes suivantes sont utilisées : 

 CanUseVariables (à la page 19) 

 Types de variables (à la page 19) 

 MaxVariables (à la page 20)  

 zenonInit (à la page 20) 

 zenonExit (à la page 21) 

 
 

CanUseVariables 

Cette méthode renvoie 1, ce qui permet d'utiliser des variables de zenon. 

short CLatchedSwitchCtrl::CanUseVariables() 

{ 

 

return 1; 

} 
 

Types de variables 

Le contrôle est uniquement utilisable avec les variables de bit, donc le résultat 0x0004 est renvoyé. 

short CLatchedSwitchCtrl::VariableTypes() 

{ 
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return 0x0004;    // Variables de bit uniquement 

} 
 

MaxVariables 

Deux variables peuvent être utilisées. La valeur 2 est donc renvoyée. 

short CLatchedSwitchCtrl::MaxVariables() 

{ 

 

return 2; // 2 variables 

} 
 

zenonInit 

Cette méthode obtient les drivers de répartition (Dispatchdriver ) des variables via le pointeur de 
répartition (Dispatchpointer) de l'élément dynamique. Avec ce pointeur (Pointer ), les valeurs des 
variables sont lues et écrites lorsque l'utilisateur clique et lors du traçage du contrôle. 

 

BOOL CLatchedSwitchCtrl::zenonInit(LPDISPATCH dispElement) 

{ 

m_dElement = IElement(dispElement); 

Element.m_lpDispatch->AddRef(); 

if (m_dElement.GetCountVariable() >= 2) 

{ 

short iIndex = 0; 

m_dSwitchVar =      IVariable(m_dElement.ItemVariable(COleVariant(iIndex))); 

m_dLatchVar =      IVariable(m_dElement.ItemVariable(COleVariant(++iIndex))); 

} 

return TRUE; 

} 
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  Informations 

Element.m_lpDispatch->AddRef(); 

Objects that are not used are automatically deleted from the memory. This must be carried 
out by the programming. The programmer determines whether an object - based on a 
reference counter - can be removed. 

COM uses the IUnknow methods AddRef and Release  to administer the number of 
references of interfaces to an object.  

The general rule for calling up these methods are: 

 AddRef must always be called up on the interface if the client receives an interface 
pointer. 

 A Release must always be called up if the client ends the use of the interface pointer.  

With a simple implementation, a counter variable in the object is increased with an AddRef 

call. Each call of a Release reduces this counter in the object. If this counter is at ZERO 
again, the interface can be removed from the memory. 

 

A reference counter can also be implemented so that each reference to the object (and not 
to an individual interface) is counted. 

In this case, each AddRef and each Release substitute call up a central implementation to 

the object. A Release then unlocks the complete object if the reference counter has 
reached zero. 

 
 

zenonExit 

Cette méthode libère le driver de répartition. 

BOOL CLatchedSwitchCtrl::zenonExit() 

{ 

 

m_dElement.ReleaseDispatch(); 

m_dSwitchVar.ReleaseDispatch(); 

m_dLatchVar.ReleaseDispatch(); 

return TRUE; 

} 
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4.2.4 Utilisation et affichage 

Écrire valeur prescrite : 

Une valeur peut être définie en cliquant sur le contrôle avec le bouton gauche de la souris.  

Si m_iSollwertDirekt est égal à 0, une boîte de dialogue de sélection de la valeur prescrite s'affiche ; dans 
le cas contraire, la valeur actuelle de la variable de commutation est inversée.  

Si la variable de verrouillage possède la valeur 1, seule la fonction MessageBeep est exécutée. Aucune 
valeur ne peut être définie par le biais du contrôle. 

void CLatchedSwitchCtrl::OnLButtonDown(UINT nFlags, CPoint point) 

{ 

 

CRect rcBounds; 

GetWindowRect(&rcBounds); 

 

COleVariant coleValue((BYTE)TRUE); 

BOOL bLatch = (BOOL)VariantToDouble((LPVARIANT)&m_dLatchVar.GetValue()); 

BOOL bSwitch = (BOOL)VariantToDouble((LPVARIANT)&m_dSwitchVar.GetValue()); 

  

if (bLatch)   // Verrouilllée !!! 

 

MessageBeep(MB_ICONEXCLAMATION); 

else 

{ 

 

if (m_sollwertDirekt) 

{ 

 

bSwitch = !bSwitch; 

} 

else 

{ 

 

CSollwertDlg dlg; 

dlg.m_iSollwert = bSwitch ? 1 : 0; 

if (dlg.DoModal() == IDOK) 

{ 
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if (dlg.m_iSollwert == 2)   // Changement 

 

bSwitch = !bSwitch; 

else 

 

bSwitch = (BOOL)dlg.m_iSollwert; 

} 

} 

coleValue = (double)bSwitch; 

m_dSwitchVar.SetValue(coleValue); 

} 

COleControl::OnLButtonDown(nFlags, point); 

} 
 

Dessin 

Lors du tracé du contrôle, les valeurs des variables sont lues depuis les drivers de répartition et l'un des 
quatre éléments graphiques définis est affiché. Lorsque la valeur d'une variable est modifiée, le contrôle 
est actualisé par le processus OnDraw. 

void CLatchedSwitchCtrl::OnDraw(CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid) 

{ 

 

CRect rcBitmap = rcBounds; 

rcBitmap.NormalizeRect(); 

  

if (!m_dElement) 

{ 

 

m_SwitchOn.Render(pdc, &rcBounds, &rcBounds); 

return; 

} 

  

BOOL bVal1 = 0, bVal2 = 0; 

VARIANT vRes; 

if (m_dSwitchVar)     // La variable existe-t-elle ? 

{ 

 

vRes = m_dSwitchVar.GetValue(); 



ActiveX 

 

 

24 

 

 

bVal1 = (BOOL)VariantToDouble(&vRes); 

} 

if (m_dLatchVar)     // La variable existe-t-elle ? 

{ 

 

vRes = m_dLatchVar.GetValue(); 

bVal1 = (BOOL)VariantToDouble(&vRes); 

} 

  

 

if (bVal1 && bVal2) 

 

m_SwitchOn.Render(pdc, rcBitmap, rcBitmap); 

else if (!bVal1 && bVal2) 

 

m_SwitchOff.Render(pdc, rcBitmap, rcBitmap); 

else if (bVal1 && !bVal2) 

 

m_LatchedOn.Render(pdc, rcBitmap, rcBitmap); 

else 

 

m_LatchedOff.Render(pdc, rcBitmap, rcBitmap); 

} 
 

4.2.5 Interface de zenon 

Les classes résultant de COleDispatchDriver doivent être créées pour l'élément et les variables, afin que 
l'interface de répartition de zenon puisse être utilisée pour définir les valeurs. La manière la plus simple 
de créer ces dernières consiste à utiliser l'Assistant Classes de l'environnement de développement 
(cliquez sur le bouton Ajouter une classe, puis sélectionnez Depuis une bibliothèque de types et 
zenrt32.tlb).  

Pour notre contrôle, ces classes sont IElement et IVariable. Elles sont définies dans zenrt32.h et 

zenrt32.cpp. 
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4.3 Exemple : CD SliderCtrl (C++) 

L'exemple suivant décrit un contrôle ActiveX équivalent au contrôle Windows SliderCtrl. Ce composant 
peut être lié à une variable de zenon. L'utilisateur peut modifier la valeur d'une variable à l'aide de ce 
curseur. Si la valeur de la variable est modifiée avec un autre élément dynamique, le curseur est mis à 
jour. 
 

4.3.1 Interface 

Le contrôle CD_SliderCtrl comporte l'interface de répartition suivante : 

[ uuid(5CD1B01D-015E-11D4-A1DF-080009FD837F), 

  helpstring(Dispatch interface for CD_SliderCtrl Control), hidden 

] 

dispinterface _DCD_SliderCtrl 

{ 

properties: //*** Propriétés des contrôles 

 

[id(1)] short TickRaster; 

[id(2)] boolean ShowVertical; 

[id(3)] short LineSize; 

  

methods: //*** Méthode du contrôle (pour ActiveX dans zenon) 

 

[id(4)] boolean zenonInit(IDispatch* pElementInterface); 

[id(5)] boolean zenonExit(); 

[id(6)] short VariableTypes(); 

[id(7)] short CanUseVariables(); 

[id(8)] short MaxVariables(); 

  

[id(DISPID_ABOUTBOX)] void AboutBox(); 

}; 
 

4.3.2 Contrôle 

La mise en œuvre du contrôle s'effectue par le biais de la classe CD_SliderCtrlCtrl. Cette classe comporte 
un membre CSliderCtrl standard de Windows, le contrôle étant sous-classé à cet élément. Les 
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interfaces IVariable et IElement contiennent des interfaces de zenon devant être intégrées. Celles-ci 
découlent de COleDispatchDriver. 

class CCD_SliderCtrlCtrl : public COleControl 

{ 

 

DECLARE_DYNCREATE(CCD_SliderCtrlCtrl) 

private: //*** Variables membres 

  

BOOL m_bInitialized; 

BOOL          m_bShowVertical; 

BOOL m_bTicksBoth; 

long          m_nRangeStart; 

long          m_nRangeEnd; 

long m_nTickOrientation; 

IVariable     m_interfaceVariable; 

IElement      m_interfaceElement; 

CSliderCtrl   m_wndSliderCtrl; 

  

public: 

 

CCD_SliderCtrlCtrl(); 

  

//{{AFX_VIRTUAL(CCD_SliderCtrlCtrl) 

public: 

virtual void OnDraw (CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid); 

virtual BOOL PreCreateWindow(CREATESTRUCT& cs); 

virtual void DoPropExchange (CPropExchange* pPX); 

virtual void OnResetState   (); 

//}}AFX_VIRTUAL 

  

protected: 

 

~CCD_SliderCtrlCtrl(); 

//*** méthodes de conversion de la variante 

double VariantToDouble(const VARIANT FAR *vValue); 

  

DECLARE_OLECREATE_EX(CCD_SliderCtrlCtrl)    // Fabrique de classe et guid 

 

DECLARE_OLETYPELIB  (CCD_SliderCtrlCtrl)      // GetTypeInfo 
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DECLARE_PROPPAGEIDS (CCD_SliderCtrlCtrl)     // ID de page de propriété 

DECLARE_OLECTLTYPE (CCD_SliderCtrlCtrl) // Nom de type et informations d'état diverses 

  

 

//*** méthodes de fonctionnement de l'élément SliderCtrl 

BOOL    IsSubclassedControl (); 

LRESULT OnOcmCommand        (WPARAM wParam, LPARAM lParam); 

  

 

//{{AFX_MSG(CCD_SliderCtrlCtrl) 

afx_msg int   OnCreate(LPCREATESTRUCT lpCreateStruct); 

afx_msg void  HScroll(UINT nSBCode, UINT nPos); 

afx_msg void  HScroll(UINT nSBCode, UINT nPos); 

afx_msg void OnLButtonDown(UINT nFlags, CPoint point); 

afx_msg void OnLButtonUp(UINT nFlags, CPoint point); 

//}}AFX_MSG 

DECLARE_MESSAGE_MAP() 

  

 

//{{AFX_DISPATCH(CCD_SliderCtrlCtrl) 

afx_msg BOOL GetTickOnBothSides(); 

afx_msg void SetTickOnBothSides (short nNewValue); 

afx_msg BOOL GetShowVertical(); 

afx_msg void SetShowVertical(BOOL bNewValue); 

afx_msg short GetTickOrientation(); 

afx_msg void SetTickOrientation (short nNewValue); 

afx_msg BOOL zenonInit(LPDISPATCH pElementInterface); 

afx_msg BOOL zenonExit(); 

afx_msg short VariableTypes(); 

afx_msg short CanUseVariables(); 

afx_msg short MaxVariables(); 

//}}AFX_DISPATCH 

DECLARE_DISPATCH_MAP() 

  

afx_msg void AboutBox(); 

  

//{{AFX_EVENT(CCD_SliderCtrlCtrl) 

//}}AFX_EVENT 

DECLARE_EVENT_MAP() 
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public: 

 

enum { 

//{{AFX_DISP_ID(CCD_SliderCtrlCtrl) 

dispidShowVertical = 1L, 

dispidTicksOnBothSides = 2L, 

dispidTickOrientation = 3L, 

dispidZenOnInit = 4L, 

dispidZenOnExit = 5L, 

dispidVariableTypes = 6L, 

dispidCanUseVariables = 7L, 

dispidMaxVariables = 8L, 

//}}AFX_DISP_ID 

}; 

}; 
 

4.3.3 Méthodes 

Les méthodes suivantes sont utilisées : 

 CanUseVariables (à la page 28) 

 Types de variables (à la page 29) 

 MaxVariables (à la page 29) 

 zenonInit (à la page 29) 

 zenonExit (à la page 30) 

 
 

CanUseVariables 

Cette méthode renvoie 1, ce qui permet d'utiliser des variables de zenon. 

short CCD_SliderCtrlCtrl::CanUseVariables() 

{ 

 

return 1; 

} 
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Types de variables 

Le contrôle peut utiliser les variables de type mot, octet, double mot et flottante. Vous trouverez une 
liste des types de données utilisables dans la description (à la page 10) générale de cette méthode. 

short CCD_SliderCtrlCtrl::VariableTypes() 

{ 

 

return 0x0001 | // Mot 

 

0x0002 | // Octet 

0x0008 | // DWord 

0x0010 | // Flottante 

0x0020 | // D flottante 

} 
 

MaxVariables 

Une seule variable peut être liée à ce contrôle. 

short CCD_SliderCtrlCtrl::MaxVariables() 

{ 

 

return 1; // 1 variables 

} 
 

zenonInit 

Le paramètre dispElement contient l'interface de l'élément dynamique. Cet élément permet de 
déterminer la variable zenon liée. Si elle est valide, la plage d'affichage du contrôle SlideCtrl est définie. 
En outre, les paramètres d'affichage (nombre de graduations, etc.) sont définis. Si aucune variable n'est 
liée, la plage d'affichage définie s'étend de 0 à 0. Le contrôle SliderCtrl ne peut donc pas être modifié. La 
variable m_bInitialized définit la capacité d'ajuster les valeurs. 

BOOL CCD_SliderCtrlCtrl::zenonInit(LPDISPATCH dispElement) 

{ 

//*** Déterminer la variable à l'aide de l'élément de zenon 

 

m_interfaceElement =    IElement(pElementInterface); 

if (m_interfaceElement.GetCountVariable() > 0) { 

 

short nIndex = 0; 
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m_interfaceVariable = IVariable 

(m_interfaceElement.ItemVariable(COleVariant(nIndex))); 

} 

  

//*** Initialiser la taille du contrôle Slider-Ctrl 

if (m_interfaceVariable) { 

 

//*** Définir la plage 

m_nRangeStart = (long) VariantToDouble(&m_interfaceVariable.GetRangeMin()); 

m_nRangeEnd = (long) VariantToDouble(&m_interfaceVariable.GetRangeMax()); 

m_wndSliderCtrl.SetRange(m_nRangeStart,m_nRangeEnd,TRUE); 

//*** Définir les graduations intermédiaires 

m_wndSliderCtrl.SetTicFreq(m_nTickCount); 

m_wndSliderCtrl.SetPageSize(m_nTickCount); 

m_wndSliderCtrl.SetLineSize(m_nLineSize); 

} else { 

 

m_wndSliderCtrl.SetRange(0,0,TRUE); 

return FALSE; 

} 

  

m_bInitialized = TRUE; 

return TRUE; 

}  
 

zenonExit 

Dans cette méthode, les interfaces de zenon sont à nouveau libérées. 

BOOL CCD_SliderCtrlCtrl::zenonExit() 

{ 

 

m_interfaceElement.ReleaseDispatch(); 

m_interfaceVariable.ReleaseDispatch(); 

return TRUE; 

} 
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4.3.4 Utilisation et affichage 

Dessin 

DoSuperclassPaint dessine l'élément SliderCtrl (il s'agit d'un contrôle sous-classé). Si le curseur est 
déplacé lors de l'étape de dessin, la variable m_bInitialized reçoit la valeur FALSE. Ceci garantit que la 
valeur peut être modifiée. Normalement, la valeur de la variable est lue et affichée avec la méthode 
SetPos de l'élément SliderCtrl. 

void CCD_SliderCtrlCtrl::OnDraw(CDC* pdc, const CRect& rcBounds, const CRect& rcInvalid) 

{ 

 

//*** actualiser l'affichage 

DoSuperclassPaint(pdc, rcBounds); 

if (m_interfaceVariable && m_bInitialized) { 

 

COleVariant cValue(m_interfaceVariable.GetValue()); 

int nValue = (int) VariantToDouble(&cValue.Detach()); 

m_wndSliderCtrl.SetPos(nValue); 

} 

} 
 

Écrire valeur prescrite : 

Dans la méthode LButtonDown, la variable m_bInitialized est définie sur FALSE et, dans l'événement 
LbuttonUp, elle est à nouveau définie sur TRUE. Ceci garantit que la valeur peut être modifiée. Dans le 
cas contraire, la procédure OnDrawserait exécutée et l'ancienne valeur serait affichée. 

void CCD_SliderCtrlCtrl::OnLButtonDown(UINT nFlags, CPoint point) 

{ 

 m_bInitialized = FALSE; 

 COleControl::OnLButtonDown(nFlags, point); 

} 

 

void CCD_SliderCtrlCtrl::OnLButtonUp(UINT nFlags, CPoint point) 

{ 

 m_bInitialized = TRUE; 

 COleControl::OnLButtonUp(nFlags, point); 

} 
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Une valeur est transmise au matériel lorsque le curseur est déplacé. Dans les méthodes Hscroll et 
Vscroll, la valeur est transmise au matériel (selon la configuration horizontale ou verticale du curseur). 

void CCD_SliderCtrlCtrl::HScroll(UINT nSBCode, UINT nPos) 

{ 

 

switch (nSBCode) { 

 

case TB_LINEUP: 

case TB_PAGEUP: 

case TB_LINEDOWN: 

case TB_PAGEDOWN: 

case TB_THUMBTRACK: 

case TB_THUMBPOSITION:{ 

 

//*** Définir la valeur sans boîte de dialogue ? 

int nValue =         m_wndSliderCtrl.GetPos(); 

COleVariant cValue((short) nValue,VT_I2); 

m_interfaceVariable.SetValue(cValue); 

} 

} 

} 
 

4.3.5 Interface de zenon 

Les classes résultant de COleDispatchDriver doivent être créées pour l'élément et les variables, afin que 
l'interface de répartition de zenon puisse être utilisée pour définir les valeurs. La manière la plus simple 
de créer ces dernières consiste à utiliser l'Assistant Classes de l'environnement de développement 
(cliquez sur le bouton Ajouter une classe, puis sélectionnez Depuis une bibliothèque de types et 
zenrt32.tlb).  

Pour notre contrôle, ces classes sont IElement et IVariable. Elles sont définies dans zenrt32.h et 
zenrt32.cpp. 
 

4.4 Exemple : contrôle. NET exécuté en tant que contrôle ActiveX 
(C#) 

L'exemple suivant décrit un contrôle .NET exécuté comme un contrôle ActiveX dans zenon.  
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La création et l'intégration se déroulent en quatre étapes : 

1. Création d'un contrôle de formulaire Windows (à la page 33) 

2. Conversion d'un contrôle utilisateur .NET en double contrôle (à la page 36) 

3. Utilisation avec ActiveX dans Editor via le code VBA (à la page 41) 

4. Connexion de variables de zenon au contrôle utilisateur .NET (à la page 42) 

  Informations 

The screenshots for this theme are only available in English. 

 
 

4.4.1 Création d'un contrôle de formulaire Windows 

Pour créer un contrôle de formulaire Windows : 

1. Démarrez Visual Studio 2008 et créez un nouveau projet Windows Form Control Library 
(Bibliothèque de contrôles de formulaire Windows) : 
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2. Renommez le contrôle par défaut avec le nom de contrôle souhaité.  
Pour cet exemple : SampesControl.cs. 

 

3. Ouvrez le concepteur de contrôles et ajoutez le contrôle souhaité (dans notre cas, un champ de 
texte) : 
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4. Les contrôles comportent normalement des propriétés. Ouvrez le concepteur de code en 
sélectionnant la fonction Afficher le code, puis ajoutez les propriétés devant que vous souhaitez 
rendre disponibles au niveau externe.  
Pour cet exemple : la propriété visible au niveau externe "UserText", avec l'accès get et set, qui 
contient le texte du champ de texte : 

 

5. Compilez le projet. 

Le contrôle de formulaire Windows peut maintenant être utilisé dans d'autres projets de 
formulaires Windows.  
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Important : le contrôle doit être inséré manuellement dans la boîte à outils de contrôle par le 
biais de la fonction Choisir les éléments.  

 
 

4.4.2 Conversion d'un contrôle utilisateur .NET en double contrôle 

Pour convertir un contrôle .NET en double contrôle, vous devez d'abord activer l'interface COM pour 
ActiveX.  
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1. Ouvrez le projet et activez la propriété Inscrire pour COM interop dans les paramètres Générer : 

 

2. Ouvrez le fichier AssemblyInfo.cs et  

 définissez l'attribut ComVisible sur true 

 ajoutez l'attribut ClassInterface 

[assembly: ComVisible(true)] 
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[assembly: ClassInterface(ClassInterfaceType.AutoDual)] 
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3. Ouvrez le concepteur de code en sélectionnant l'option Afficher le code, puis ajoutez les 
attributs ActiveX et les entrées using requis. Dans le menu Outils/Create GUID, créez un 
nouveau GUID pour l'attribut GUID : 

 

4. Pour que le contrôle puisse être sélectionné comme un contrôle d'interface utilisateur Active X, 
vous devez ajouter des fonctions aux classes de contrôle suivantes : 

 RegisterClass 
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 UnregisterClass 

 

Vous pouvez ensuite inscrire le contrôle dans la base de registres.  

5. Recompilez le projet.  

Le contrôle de formulaire Windows est maintenant utilisable dans ActiveX, et a été inscrit 
automatiquement durant la création de la nouvelle version. Un fichier typelib supplémentaire, 
zenonDotNetControl.tlb, a été créé dans le répertoire de sortie. 

6. Pour utiliser le contrôle sur un autre ordinateur : 

a) Copiez le fichier DLL et le fichier TLB sur l'ordinateur cible 

b) Enregistrez les fichiers en saisissant la ligne de commande : 
%windir%\Microsoft.NET\Framework\v2.0.50727\regasm.exe zenonDotNetControl.dll 

/tlb:zenonDotNetControl.tlb 
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7. Ajoutez le contrôle de formulaire étendu de Windows en tant que contrôle ActiveX dans zenon 
Editor : 

 
 

4.4.3 Utilisation avec ActiveX dans Editor via le code VBA 

Pour accéder aux propriétés du contrôle dans zenon Editor : 

1. Dans zenon Editor, dans le nœud Interfaces de programmation/Macros VBA, créez une nouvelle 
macro Init avec le nom Init_ActiveX.  

Dans cette macro, vous pouvez accéder à toutes les propriétés externes via obElem.ActiveX.  
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2. Attribuez cette macro au contrôle ActiveX via les propriétés macros VBA/Init de l'élément 
ActiveX. 

 

EXEMPLE DE MACRO INIT 

Public Sub Init_ActiveX(obElem As Element) 

    obElem.AktiveX.Usertext = "Attribuez la chaîne au contrôle" 

End Sub 
 

4.4.4 Connexion de variables de zenon au contrôle utilisateur .NET 

Dans zenon, vous avez la possibilité d'améliorer un contrôle ActiveX avec des fonctions spéciales pour 
accéder à l'API zenon.  
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MÉTHODES REQUISES 

 public bool zenonInit (à la page 44) (appelé durant l'initialisation du contrôle dans le Runtime de 
zenon.) 

 public bool zenonInitED (à la page 44) (utilisé dans Editor.) 

 public bool zenonExit() (à la page 45) (appelé lors de la destruction du contrôle dans le Runtime 
de zenon.) 

 public bool zenonExitED() (à la page 45) (utilisé dans Editor.) 

 public short CanUseVariables() (à la page 45) (prend en charge la liaison de variables.) 

 public short VariableTypes() (à la page 45) (types de données pris en charge par le contrôle) 

 public MaxVariables() (à la page 46) (nombre maximal de variables pouvant être liées au 
contrôle.) 

AJOUT DE RÉFÉRENCES 

1. Dans Microsoft Visual Studio, sous Ajouter des références, sélectionnez la bibliothèque d'objets 
de zenon pour pouvoir accéder à l'API de zenon dans le contrôle.  

 

2. Ajoutez les fonctions améliorées au code de classe du contrôle pour accéder à l'ensemble de 
l'API de zenon.  
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Dans notre exemple, l'objet COM d'une variable de zenon est temporairement enregistré dans 
un membre, afin d'être accessible ultérieurement via l'événement Paint du contrôle.   

 
 

public bool zenOnInit(zenOn.Element dispElement) 

Cette méthode (dans le Runtime) permet au contrôle ActiveX d'obtenir un pointeur vers l'interface de 
répartition de l'élément dynamique. Ce pointeur permet également d'accéder aux variables de zenon 
liées à l'élément dynamique.  

Vous pouvez configurer l'ordre de transmission des variables dans la boîte de dialogue Entrer les 
propriétés, à l'aides des boutons Bas et Haut. La boîte de dialogue Entrer les propriétés s'affiche si : 

 Vous double-cliquez sur l'élément ActiveX, ou 

 Vous sélectionnez Propriétés dans le menu contextuel, ou 

 Vous sélectionnez la propriété Paramètres ActiveX dans le nœud Affichage de la fenêtre de 
propriétés 

 
 

public bool zenonInitED(zenon.Element dispElement) 

Équivalent à public bool zenonInit (à la page 44) ; exécuté lors de l'ouverture d'ActiveX dans Editor 
(double-cliquez sur le contrôle ActiveX).  
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public bool zenOnExit() 

Cette méthode est appelée par le Runtime de zenon lorsque le contrôle ActiveX est fermé. Ici, tous les 
pointeurs de répartition renvoyant à des variables doivent être libérés.  
 

public bool zenonExitED() 

Équivalent à public bool zenonExit() (à la page 45) ; exécuté lors de la fermeture d'ActiveX dans Editor. 
Permet de réagir aux changements (par exemple, aux modifications de valeurs) dans Editor.  
 

public short CanUseVariables() 

Cette méthode renvoie 1 si le contrôle peut utiliser les variables de zenon, et 0 dans le cas contraire.  

 1 : Pour l'élément dynamique (via le bouton Variable), vous pouvez uniquement déclarer des 
variables de zenon avec le type déclaré par le biais de la méthode VariableTypes, 
conformément au nombre défini par la méthode MaxVariables. 

 0 : si CanUseVariables renvoie 0 ou le contrôle ne comporte pas cette méthode, n'importe quel 
nombre de variables de tout type peut être défini, sans limitation aucune. Dans le Runtime, 
toutefois, ces variables sont uniquement utilisables avec du code VBA.  

 
 

public short VariableTypes() 

La valeur renvoyée par cette méthode est utilisée comme masque pour les types de variable utilisables 
dans la liste de variables. La valeur est une relation AND (et) parmi les valeurs suivantes (définies dans 
zenon32/dy_type.h) : 

Paramètres Valeur Description 

WORD 0x0001 correspond à la position 0 

BYTE 0x0002 correspond à la position 1 

BIT 0x0004 correspond à la position 2 

DWORD 0x0008 correspond à la position 3 

FLOAT 0x0010 correspond à la position 4 

DFLOAT 0x0020 correspond à la position 5 

STRING 0x0040 correspond à la position 6 

IN_OUTPUT 0x8000 correspond à la position 15 
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public MaxVariables() 

Dans cette section est défini le nombre de variables pouvant être sélectionnées dans la liste de 
variables.  

1 : la sélection multiple est désactivée dans la liste de variables. Un avertissement est alors affiché si 
plusieurs variables sont sélectionnées. 
 

5. Contrôles utilisateur .NET 

Le contrôle .NET permet d'améliorer de manière autonome les fonctionnalités du Runtime de zenon et 
d'Editor.  

Dans ce manuel, vous trouverez des informations concernant : 

 La différence entre un conteneur de contrôle et ActiveX (à la page 46)  

 Exemple de conteneur de contrôle .NET (à la page 47) 

 Exemple : contrôle. NET exécuté en tant que contrôle ActiveX (C#) (à la page 32) 

Vous trouverez d'autres informations concernant les contrôles .NET dans ActiveX dans le manuel 
Synoptiques, au chapitre Contrôles .NET. 
 

5.1 Différentes utilisations des contrôles .NET Control dans le 
conteneur de contrôles ou ActiveX 

Un contrôle utilisateur .NET peut être :  

 Intégré directement à l'élément ActiveX de zenon, via le contrôle CD_DotNetControlContainer 

 Utilisé comme un contrôle ActiveX et intégré directement à l'élément ActiveX zenon 

Principalement, les différences entre le contrôle de conteneur et le contrôle ActiveX sont les suivantes : 

Contrôle CD_DotNetControlContainer  Contrôle Active X  

 Ne doit pas être inscrit sur l'ordinateur.  Doit être inscrit en tant que contrôle Active X sur 
l'ordinateur (regsrv32). 

 En cas de modification du contrôleur, seule 
le fichier DLL doit être modifié. 

 En cas de modification au niveau du contrôleur, 
l'élément TLB doit être réinscrit. 

 L'accès via VBA et VSTA est uniquement 
possible par le biais de la méthode 
CD_DotNetControlContainer. 

 Accès facile via VBA et VSTA. 
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5.2 Exemple de conteneur de contrôle .NET 

Dans ce didacticiel, vous allez découvrir comment créer un contrôle utilisateur .NET simple dans Visual 
Studio 2010 (langage de programmation C#) et comment l'intégrer, à l'aide du contrôle 
CD_DotNetControlContainer de zenon, sous forme de contrôle ActiveX dans un élément ActiveX de 
zenon.  
 

5.2.1 Général 

Le contrôle CD_DotNetControlContainer agit donc comme un wrapper entre le contrôle utilisateur et 
l'élément ActiveX de zenon. Toutes les méthodes utilisées dans l'exemple suivant, et toutes les 
méthodes publiques et propriétés sont transmises, via le contrôle CD_DotNetControlContainer, du 
contrôle utilisateur au contrôle ActiveX, et peuvent être utilisés par zenon (dans VBA et VSTA 
également).  

Si une référence à l'interface de programmation de zenon est présente dans le contrôle utilisateur, vous 
pouvez directement accéder aux objets de >CD_PRODUCTNAME<. 

 

Dans l'exemple suivant, nous allons : 

 Créer un contrôle utilisateur .NET (à la page 49) 

 Ajouter un conteneur CD_DotNetControlContainer et un contrôle utilisateur .NET (à la page 58)  

 Autoriser l'accès au contrôle utilisateur via VSTA (VBA)  (à la page 63) 

CHEMIN DE LA DLL DANS EDITOR ET LE RUNTIME 

Le chemin d'accès à .Net DLL sélectionné dans Editor est également utilisé dans le Runtime. Il est défini 
comme un chemin absolu, et ne peut pas être modifié. 
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Assurez-vous d'utiliser le même chemin sur tous les ordinateurs sur le réseau zenon pour Editor et le 
Runtime.  
Conseil : Sélectionnez un chemin absolu, par exemple : C:\Controls. Saisissez le chemin tel qu'il est 
défini dans Remote-Transport et dans .NET Control Container. Utilisez Remote-Transport pour 
harmoniser ce chemin avec tous les ordinateurs.  
 

public bool zenOnInit(zenOn.Element dispElement) 

Cette méthode (dans le Runtime) permet au contrôle ActiveX d'obtenir un pointeur vers l'interface de 
répartition de l'élément dynamique. Ce pointeur permet également d'accéder aux variables de zenon 
liées à l'élément dynamique.  

Vous pouvez configurer l'ordre de transmission des variables dans la boîte de dialogue Entrer les 
propriétés, à l'aides des boutons Bas et Haut. La boîte de dialogue Entrer les propriétés s'affiche si : 

 Vous double-cliquez sur l'élément ActiveX, ou 

 Vous sélectionnez Propriétés dans le menu contextuel, ou 

 Vous sélectionnez la propriété Paramètres ActiveX dans le nœud Affichage de la fenêtre de 
propriétés 

 
 

public bool zenOnExit() 

Cette méthode est appelée par le Runtime de zenon lorsque le contrôle ActiveX est fermé. Ici, tous les 
pointeurs de répartition renvoyant à des variables doivent être libérés.  
 

public short CanUseVariables() 

Cette méthode renvoie 1 si le contrôle peut utiliser les variables de zenon, et 0 dans le cas contraire.  

 1 : Pour l'élément dynamique (via le bouton Variable), vous pouvez uniquement déclarer des 
variables de zenon avec le type déclaré par le biais de la méthode VariableTypes, 
conformément au nombre défini par la méthode MaxVariables. 

 0 : si CanUseVariables renvoie 0 ou le contrôle ne comporte pas cette méthode, n'importe quel 
nombre de variables de tout type peut être défini, sans limitation aucune. Dans le Runtime, 
toutefois, ces variables sont uniquement utilisables avec du code VBA.  

 
 



Contrôles utilisateur .NET 

 

 

49 

 

 

public short VariableTypes() 

La valeur renvoyée par cette méthode est utilisée comme masque pour les types de variable utilisables 
dans la liste de variables. La valeur est une relation AND (et) parmi les valeurs suivantes (définies dans 
zenon32/dy_type.h) : 

Paramètres Valeur Description 

WORD 0x0001 correspond à la position 0 

BYTE 0x0002 correspond à la position 1 

BIT 0x0004 correspond à la position 2 

DWORD 0x0008 correspond à la position 3 

FLOAT 0x0010 correspond à la position 4 

DFLOAT 0x0020 correspond à la position 5 

STRING 0x0040 correspond à la position 6 

IN_OUTPUT 0x8000 correspond à la position 15 

 
 

public MaxVariables() 

Dans cette section est défini le nombre de variables pouvant être sélectionnées dans la liste de 
variables.  

1 : la sélection multiple est désactivée dans la liste de variables. Un avertissement est alors affiché si 
plusieurs variables sont sélectionnées. 
 

5.2.2 Créer un contrôle utilisateur .NET 

Un contrôle utilisateur est un contrôle simple, permettant de définir une nouvelle valeur par le biais 
d'un champ de saisie (champ de texte). Lorsque vous cliquez sur le bouton, la valeur est écrite dans la 
variable zenon de votre choix. 

Une fonction supplémentaire doit automatiquement détecter tout changement de valeur de la variable 
dans zenon et afficher automatiquement la nouvelle valeur dans le contrôle. 

  Informations 

The screenshots for this theme are only available in English. 
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PROCÉDURE 

1. Créez d'abord un nouveau projet dans VS, et utilisez le type de projet Bibliothèque de contrôles 

Windows Forms  

Important : spécifiez la version 3.5 de .NET Framework ! 

 

2. Renommez ensuite le fichier CS de "UserControl" en "zenon_CD_DotNetControlContainer.cs". 
Les fichiers Designer.cs et .resx sont renommés automatiquement. 

 

3. À l'étape suivante, vous créez le contrôle utilisateur. Pour cela, utilisez deux champs de texte 
pour l'entrée et la sortie, respectivement, et un bouton permettant d'écrire de nouvelles valeurs 
dans la variable zenon.  
Nom :   

 Premier champ de texte : "txtGetzenonVariable"   

 Deuxième champ de texte : "txtSetzenonVariable"  
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 Bouton : "btnSetzenonVariable" 

 

4. Pour accéder aux objets de zenon, vous devez disposer d'une référence à l'interface de 
programmation de zenon. Pour cela : 

 Cliquez sur le nœud Références dans l'Explorateur de solutions  

 Ouvrez menu contextuel 

 Sélectionnez Ajouter des références...  

 Sélectionnez l'onglet COM 

 Sélectionnez zenon programming interface library (Bibliothèque d'interfaces de 
programmation de zenon) 

 

La référence zenon devrait alors être visible dans la liste de références. 
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5. À l'étape suivante, créez une variable globale du type zenon.variable dans le code de 
zenon_CD_DotNetControlContainer.cs :  

 

6. Cette variable est initialisée par le biais de la méthode publique zenonInit :  

 

et activée via la méthode publique zenonExit :  

 

Dans les méthodes suivantes, nous définissons si des variables et des types de données de zenon 
sont utilisés, ainsi que le nombre de variables pouvant être transmis : 
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7. À l'étape suivante, dans le paramètre Click-Event du bouton btnSetzenonVariable, définissez 
qu'un clic sur le bouton écrit la valeur du champ de texte txtSetzenonVariable dans la variable 
zenon, avant d'effacer le contenu du champ de texte. 

 

8. Pour réagir à un changement de valeur de la variable, vous devez avoir accès à l'événement 
Paint du contrôle. L'événement Paint est également déclenché si la valeur de la variable 
initialisée de zenon change, et peut donc être utilisé pour actualiser des valeurs. Puisque les 
variables référencées dans l'élément ActiveX de zenon sont automatiquement suggérées, vous 
n'avez généralement pas besoin d'utiliser le conteneur zenon.OnlineVariable dans le contrôle. 

 

APERÇU DU CODE 

Voici un récapitulatif de l'ensemble du code : 

using System; 

using System.Collections.Generic; 

using System.ComponentModel; 

using System.Drawing; 

using System.Data; 

using System.Linq; 

using System.Text; 

using System.Windows.Forms; 

using zenOn; 

namespace zenon_CD_DotNetControlContainer 

{ 
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    public partial class zenon_CD_DotNetControlContainer : UserControl 

    { 

        //Cette ligne est nécessaire pour accéder au conteneur de variable de zenon 

        zenOn.Variable m_cVal = null; 

        public zenon_CD_DotNetControlContainer() 

        { 

            InitializeComponent(); 

        } 

    /// <summary> 

    /// Cette méthode publique sera appelée par l'initialisation du contrôle dans 

    /// le Runtime de zenon. 

    /// </summary> 

    /// <param name="dispElement"></param> 

    /// <returns></returns> 

        public bool zenOnInit(zenOn.Element dispElement) 

        { 

          //Vérifier si des variables de zenon ont été ajoutées au 

     //Contrôle 

         if (dispElement.CountVariable > 0) 

            { 

                try 

                { 

             //Prendre la première variable de zenon et l'ajouter 

             //à la variable globale 

                    m_cVal = dispElement.ItemVariable(0); 

                } 

                catch { } 

            } 

            return true; 

        } 
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    /// <summary> 

    /// Cette méthode publique sera appelée par la libération du contrôle dans 

    /// le Runtime de zenon. 

    /// </summary> 

    /// <returns></returns> 

        public bool zenOnExit() 

        { 

            try 

            { 

                if (m_cVal != null) 

                { 

                    //Libérer la variable de zenon (objet Com) 

                    System.Runtime.InteropServices.Marshal.FinalReleaseComObject(m_cVal); 

                    m_cVal = null; 

                } 

            } 

            catch { } 

            return true; 

        } 

    /// <summary> 

    /// Cette méthode publique est nécessaire pour lier les variables de zenon 

    /// au contrôle. 

    /// </summary> 

    /// <returns></returns> 

        public short CanUseVariables() 

        { 

            return 1; // Only this Variable is supported 

        } 

        /// <summary> 

        /// Cette méthode publique renvoie le type des 
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        /// variables de zenon prises en charge 

        /// </summary> 

        /// <returns></returns> 

        public short VariableTypes() 

        { 

            return short.MaxValue; // Tous les types de données pris en charge 

        } 

        /// <summary> 

        /// Cette méthode publique renvoie le nombre de 

        /// variables de zenon prises en charge 

        /// </summary> 

        /// <returns></returns> 

        public short MaxVariables() 

        { 

            return 1; // Une seule variable doit être liée au contrôle 

        } 

        /// <summary> 

        /// Celle-ci sera déclenchée en cliquant sur le bouton. La nouvelle valeur sera 

        /// définie sur la variable de zenon 

        /// </summary> 

        /// <param name="sender"></param> 

        /// <param name="e"></param> 

        private void btnSetZenonVariable_Click(object sender, EventArgs e) 

        { 

            //Valeur prescrite de TextBox pour la variable de zenon 

            m_cVal.set_Value(0,txtSetZenonVariable.Text.ToString()); 

            this.txtSetZenonVariable.Text = string.Empty; 

        } 

        /// <summary> 

        /// Celle-ci sera déclenchée par le tracé du contrôle utilisateur ou la modification 
de la valeur de la variable. 
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        /// Après la modification de la variable, le contrôle est tracé une nouvelle fois 
et la nouvelle valeur 

        /// est écrite dans le champ de texte. 

        /// </summary> 

        /// <param name="sender"></param> 

        /// <param name="e"></param> 

        private void zenon_CD_DotNetControlContainer_Paint(object sender, PaintEventArgs e) 

        { 

            if (m_cVal != null) 

            { 

                this.txtGetZenonVariable.Text = m_cVal.get_Value(0).ToString(); 

                return; 

            } 

            else 

            { 

                this.txtGetZenonVariable.Text = "Variable Value"; 

                return; 

            } 

        } 

    } 

} 

CRÉATION DE LA VERSION 

Pour finir, créez une version pour intégrer la DLL finalisée dans zenon ou le conteneur 
CD_DotNetControlContainer. 
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Pour cela, vous devez basculer du mode Débogage au mode Version finale dans les paramètres. 

  
 

5.2.3 Ajouter un conteneur CD_DotNetControlContainer et un contrôle 
utilisateur .NET 

Pour préparer le projet zenon et ajouter le conteneur CD_DotNetControlContainer et le contrôle 

utilisateur .NET, effectuez les étapes suivantes : 

1. Créez une variable interne de type String (Chaîne), et définissez la longueur de la chaîne sur 
30. 

 

2. Dans le nœud Projet/Fichiers/Autres du projet zenon, ajoutez le fichier DLL du 
contrôle utilisateur .NET que vous avez créé. 

 

Le fichier DLL se trouve dans le dossier du projet de Visual Studio, sous 
bin\Release\zenon_CD_DotNetControlContainer.dll. 
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3. Dans le projet, sélectionnez l'élément ActiveX et faites-le glisser vers un synoptique zenon.  

 La boîte de dialogue Configuration s'affiche à l'écran. 

 Sélectionnez le contrôle CD_DotNetControlContainer.Container. 

 

4. Pour incorporer le contrôle utilisateur .NET au contrôle CD_DotNetControlContainer : 

 Cliquez sur le bouton Propriétés.  

 Une nouvelle boîte de dialogue s'affiche à l'écran. 

 

 Cliquez sur le bouton Charger pour sélectionner le chemin du dossier du projet, par 
exemple : 
C:\ProgramData\COPA-DATA\SQL\9888419d-251e-4595-b396-9be423679

97c\FILES\zenon\custom\additional\zenon_CD_DotNetControlContai

ner.dll 
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En ajoutant le fichier DLL au dossier additional, le contrôle est automatiquement transféré 
lors de la copie ou du chargement des fichiers du Runtime vers un autre ordinateur. Le lien est 
alors perdu.  

 

Le contrôle utilisateur .NET devrait maintenant être affiché.  

Fermez la boîte de dialogue en cliquant sur OK. 

 

5. À la dernière étape, liez une variable au contrôle en cliquant sur le bouton Variables.  
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La variable sélectionnée est d'abord automatiquement liée avec notre variable globalement 
définie (.NET UserControl) via la méthode publique zenonInit. La liaison avec le contrôle est 
effectuée après le démarrage du Runtime. 

 

Liez ensuite la variable interne à un élément de texte.  

 

6. Après le démarrage du Runtime, le contrôle est initialement vide. 
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Si vous saisissez une valeur dans le deuxième champ de texte et la validez ensuite en cliquant sur 
le bouton Set zenon variable (Définir la variable de zenon), la valeur est écrite dans la variable 
zenon.  (L'événement btnSetzenonVariable_Click est exécuté.)  

 

Cette indication est également affichée dans l'élément de texte de zenon. 

 

Si la valeur est directement modifiée dans l'élément de texte de zenon,  

 

la valeur est directement écrite dans le premier champ de texte par le biais de l'événement Paint 
du contrôle .NET. 
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5.2.4 Accès au contrôle utilisateur via VSTA ou VBA  

Ces exemples présentent l'accès via VSTA. La procédure est la même que pour VBA. 

1. Améliorez le contrôle en spécifiant un intitulé (label) et nommez-le IblzenonInfo. Dans cet 
intitulé, la valeur d'une autre variable de zenon doit être affichée. La nouvelle valeur doit être 
définie par le biais d'une macro VSTA. 

 

2. Améliorez le code avec une propriété (Information), et ajoutez à celle-ci les propriétés get et set. 
Elles vous permettent de lire et d'écrire le texte de l'intitulé. 

 

3. Créez une nouvelle version du contrôle utilisateur et copiez-la vers le dossier additional du 
projet de zenon.  
N'oubliez pas : Fermez zenon Editor avant d'effectuer cette manipulation ! 
Supprimez l'ancien fichier DLL, puis redémarrez zenon Editor. Si la DLL se trouve encore dans le 
dossier, supprimez-la simplement une deuxième fois. Vous pouvez maintenant importer la DLL 
modifiée. Les éléments CD_DotNetContainerControl et ActiveX sont mis à jour 
automatiquement. 

4. Dans zenon Editor, cliquez sur ActiveX et ouvrez la fenêtre de la propriété.  
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Vous pouvez maintenant vois la nouvelle propriété Information dans la fenêtre de sélection du 
contrôle, et vous pouvez également définir une valeur. 

 

Cette valeur est également définie dans le contrôle ("myInformation"). 

 

5. Pour pouvoir utiliser CD_DotNetControlContainer dans VSTA ou VBA, vous devez d'abord 
disposer de la référence du contrôle. Après avoir ouvert VSTA pour le projet (ProjectAddin), 
vous devez ajouter la référence de CD_DotNetControlContainer.  
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Vous devez en outre ajouter l'Assembly System.Windows.Forms. 

 

6. Le code suivant permet de redéfinir la valeur de la propriété Information. 

 

7. Pour finir : 

 Créez une nouvelle fonction de zenon, intitulée Exécuter macro VSTA.  

 Liez la fonction à un bouton. 

Dans le Runtime, l'intitulé change de myInformation en New Information lorsque vous cliquez 
sur le bouton.  

 

Cliquez à nouveau sur le bouton pour effectuer le changement inverse. 
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5.3 Exemple : contrôle. NET exécuté en tant que contrôle ActiveX 
(C#) 

L'exemple suivant décrit un contrôle .NET exécuté comme un contrôle ActiveX dans zenon.  

La création et l'intégration se déroulent en quatre étapes : 

1. Création d'un contrôle de formulaire Windows (à la page 33) 

2. Conversion d'un contrôle utilisateur .NET en double contrôle (à la page 36) 

3. Utilisation avec ActiveX dans Editor via le code VBA (à la page 41) 

4. Connexion de variables de zenon au contrôle utilisateur .NET (à la page 42) 

  Informations 

The screenshots for this theme are only available in English. 

 
 

5.3.1 Création d'un contrôle de formulaire Windows 

Pour créer un contrôle de formulaire Windows : 

1. Démarrez Visual Studio 2008 et créez un nouveau projet Windows Form Control Library 
(Bibliothèque de contrôles de formulaire Windows) : 
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2. Renommez le contrôle par défaut avec le nom de contrôle souhaité.  
Pour cet exemple : SampesControl.cs. 

 

3. Ouvrez le concepteur de contrôles et ajoutez le contrôle souhaité (dans notre cas, un champ de 
texte) : 
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4. Les contrôles comportent normalement des propriétés. Ouvrez le concepteur de code en 
sélectionnant la fonction Afficher le code, puis ajoutez les propriétés devant que vous souhaitez 
rendre disponibles au niveau externe.  
Pour cet exemple : la propriété visible au niveau externe "UserText", avec l'accès get et set, qui 
contient le texte du champ de texte : 

 

5. Compilez le projet. 

Le contrôle de formulaire Windows peut maintenant être utilisé dans d'autres projets de 
formulaires Windows.  
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Important : le contrôle doit être inséré manuellement dans la boîte à outils de contrôle par le 
biais de la fonction Choisir les éléments.  

 
 

5.3.2 Conversion d'un contrôle utilisateur .NET en double contrôle 

Pour convertir un contrôle .NET en double contrôle, vous devez d'abord activer l'interface COM pour 
ActiveX.  
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1. Ouvrez le projet et activez la propriété Inscrire pour COM interop dans les paramètres Générer : 

 

2. Ouvrez le fichier AssemblyInfo.cs et  

 définissez l'attribut ComVisible sur true 

 ajoutez l'attribut ClassInterface 

[assembly: ComVisible(true)] 
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[assembly: ClassInterface(ClassInterfaceType.AutoDual)] 
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3. Ouvrez le concepteur de code en sélectionnant l'option Afficher le code, puis ajoutez les 
attributs ActiveX et les entrées using requis. Dans le menu Outils/Create GUID, créez un 
nouveau GUID pour l'attribut GUID : 

 

4. Pour que le contrôle puisse être sélectionné comme un contrôle d'interface utilisateur Active X, 
vous devez ajouter des fonctions aux classes de contrôle suivantes : 

 RegisterClass 
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 UnregisterClass 

 

Vous pouvez ensuite inscrire le contrôle dans la base de registres.  

5. Recompilez le projet.  

Le contrôle de formulaire Windows est maintenant utilisable dans ActiveX, et a été inscrit 
automatiquement durant la création de la nouvelle version. Un fichier typelib supplémentaire, 
zenonDotNetControl.tlb, a été créé dans le répertoire de sortie. 

6. Pour utiliser le contrôle sur un autre ordinateur : 

a) Copiez le fichier DLL et le fichier TLB sur l'ordinateur cible 

b) Enregistrez les fichiers en saisissant la ligne de commande : 
%windir%\Microsoft.NET\Framework\v2.0.50727\regasm.exe zenonDotNetControl.dll 

/tlb:zenonDotNetControl.tlb 
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7. Ajoutez le contrôle de formulaire étendu de Windows en tant que contrôle ActiveX dans zenon 
Editor : 

 
 

5.3.3 Utilisation avec ActiveX dans Editor via le code VBA 

Pour accéder aux propriétés du contrôle dans zenon Editor : 

1. Dans zenon Editor, dans le nœud Interfaces de programmation/Macros VBA, créez une nouvelle 
macro Init avec le nom Init_ActiveX.  

Dans cette macro, vous pouvez accéder à toutes les propriétés externes via obElem.ActiveX.  
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2. Attribuez cette macro au contrôle ActiveX via les propriétés macros VBA/Init de l'élément 
ActiveX. 

 

EXEMPLE DE MACRO INIT 

Public Sub Init_ActiveX(obElem As Element) 

    obElem.AktiveX.Usertext = "Attribuez la chaîne au contrôle" 

End Sub 
 

5.3.4 Connexion de variables de zenon au contrôle utilisateur .NET 

Dans zenon, vous avez la possibilité d'améliorer un contrôle ActiveX avec des fonctions spéciales pour 
accéder à l'API zenon.  
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MÉTHODES REQUISES 

 public bool zenonInit (à la page 44) (appelé durant l'initialisation du contrôle dans le Runtime de 
zenon.) 

 public bool zenonInitED (à la page 44) (utilisé dans Editor.) 

 public bool zenonExit() (à la page 45) (appelé lors de la destruction du contrôle dans le Runtime 
de zenon.) 

 public bool zenonExitED() (à la page 45) (utilisé dans Editor.) 

 public short CanUseVariables() (à la page 45) (prend en charge la liaison de variables.) 

 public short VariableTypes() (à la page 45) (types de données pris en charge par le contrôle) 

 public MaxVariables() (à la page 46) (nombre maximal de variables pouvant être liées au 
contrôle.) 

AJOUT DE RÉFÉRENCES 

1. Dans Microsoft Visual Studio, sous Ajouter des références, sélectionnez la bibliothèque d'objets 
de zenon pour pouvoir accéder à l'API de zenon dans le contrôle.  

 

2. Ajoutez les fonctions améliorées au code de classe du contrôle pour accéder à l'ensemble de 
l'API de zenon.  
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Dans notre exemple, l'objet COM d'une variable de zenon est temporairement enregistré dans 
un membre, afin d'être accessible ultérieurement via l'événement Paint du contrôle.   

 
 

public bool zenOnInit(zenOn.Element dispElement) 

Cette méthode (dans le Runtime) permet au contrôle ActiveX d'obtenir un pointeur vers l'interface de 
répartition de l'élément dynamique. Ce pointeur permet également d'accéder aux variables de zenon 
liées à l'élément dynamique.  

Vous pouvez configurer l'ordre de transmission des variables dans la boîte de dialogue Entrer les 
propriétés, à l'aides des boutons Bas et Haut. La boîte de dialogue Entrer les propriétés s'affiche si : 

 Vous double-cliquez sur l'élément ActiveX, ou 

 Vous sélectionnez Propriétés dans le menu contextuel, ou 

 Vous sélectionnez la propriété Paramètres ActiveX dans le nœud Affichage de la fenêtre de 
propriétés 

 
 

public bool zenonInitED(zenon.Element dispElement) 

Équivalent à public bool zenonInit (à la page 44) ; exécuté lors de l'ouverture d'ActiveX dans Editor 
(double-cliquez sur le contrôle ActiveX).  
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public bool zenOnExit() 

Cette méthode est appelée par le Runtime de zenon lorsque le contrôle ActiveX est fermé. Ici, tous les 
pointeurs de répartition renvoyant à des variables doivent être libérés.  
 

public bool zenonExitED() 

Équivalent à public bool zenonExit() (à la page 45) ; exécuté lors de la fermeture d'ActiveX dans Editor. 
Permet de réagir aux changements (par exemple, aux modifications de valeurs) dans Editor.  
 

public short CanUseVariables() 

Cette méthode renvoie 1 si le contrôle peut utiliser les variables de zenon, et 0 dans le cas contraire.  

 1 : Pour l'élément dynamique (via le bouton Variable), vous pouvez uniquement déclarer des 
variables de zenon avec le type déclaré par le biais de la méthode VariableTypes, 
conformément au nombre défini par la méthode MaxVariables. 

 0 : si CanUseVariables renvoie 0 ou le contrôle ne comporte pas cette méthode, n'importe quel 
nombre de variables de tout type peut être défini, sans limitation aucune. Dans le Runtime, 
toutefois, ces variables sont uniquement utilisables avec du code VBA.  

 
 

public short VariableTypes() 

La valeur renvoyée par cette méthode est utilisée comme masque pour les types de variable utilisables 
dans la liste de variables. La valeur est une relation AND (et) parmi les valeurs suivantes (définies dans 
zenon32/dy_type.h) : 

Paramètres Valeur Description 

WORD 0x0001 correspond à la position 0 

BYTE 0x0002 correspond à la position 1 

BIT 0x0004 correspond à la position 2 

DWORD 0x0008 correspond à la position 3 

FLOAT 0x0010 correspond à la position 4 

DFLOAT 0x0020 correspond à la position 5 

STRING 0x0040 correspond à la position 6 

IN_OUTPUT 0x8000 correspond à la position 15 
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public MaxVariables() 

Dans cette section est défini le nombre de variables pouvant être sélectionnées dans la liste de 
variables.  

1 : la sélection multiple est désactivée dans la liste de variables. Un avertissement est alors affiché si 
plusieurs variables sont sélectionnées. 
 

6. WPF element 

With the WPF dynamic element, valid WPF/XAML files in zenon can be integrated and displayed. 

  Informations 

All brand and product names in this documentation are trademarks or registered 
trademarks of the respective title holder. 

 
 

6.1 Basics 

XAML 

XAML stands for Extensible Application Markup Language. The XML-based descriptive text developed 
by Microsoft defines graphic elements, animations, transformations, displays of color gradients etc. in 
Silverlight and WPF user interfaces. The use of XAML makes it possible to strictly separate design and 
programming. The designer prepares, for example, the graphical user interface and creates basic 
animations that are then used by the developers/project planners who create the application logic. 

WPF 

WPF stands for Windows Presentation Foundation and describes a graphics framework that is part of 
the Windows .NET framework: 

 WPF provides a comprehensive model for the programmer. 

 XAML describes, based on XML, the interface hierarchy as a markup language. Depending on the 
construction of the XAML file, there is the possibility to link properties, events and 
transformations of WPF elements with variables and functions of  
CD_PRODUCTNAME<. 
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 The framework unites the different areas of presentation such as user interface, drawing, 
graphics, audio, video, documents and typography. 

 For execution in zenon, Microsoft .NET framework version 3.5 or higher is required. 
 

6.1.1 WPF in process visualization 

XAML makes different design possibilities possible for zenon. Display elements and dynamic elements 
can be adapted graphically regardless of the project planning. For example, laborious illustrations are 
first created by designers and then imported into zenon as an XAML file and linked to the desired logic. 
There are many possibilities for using this, for example: 

DYNAMIC ELEMENTS IN ANALOG-LOOK 

 

Graphics no longer need to be drawn in zenon, but can be imported directly as an XAML file. This makes 
it possible to use complex, elaborately illustrated elements in process visualization. Reflections, shading, 
3D effects etc. are supported as graphics. The elements that are adapted to the respective industry 
environment make intuitive operation possible, along the lines of the operating elements of the 
machine. 

INTRICATE ILLUSTRATIONS FOR INTUITIVE OPERATION 

 

The integration of XAML-based display elements improves the graphics of projects and makes it very 
easy to display processes clearly. Elements optimized for usability make operation easier. A clear display 
of data makes it easier to receive complex content. The flexible options for adapting individual elements 
makes it easier to use for the operator. It is therefore possible for the project planners to determine 
display values, scales and units on their own. 

CLEAR PRESENTATION OF DATA AND SUMMARIES 
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Grouped display elements make it possible to clearly display the most important process data, so that 
the equipment operator is always informed of the current process workflow. Graphical evaluations, 
display values and sliders can be grouped into an element and make quick and uncomplicated control 
possible. 

INDUSTRY-SPECIFIC DISPLAYS 

 

Elements such as thermometers, scales or bar graphs are part of the basic elements of process 
visualization. It is possible, using XAML, to adapt these to the respective industry. Thus equipment 
operators can find the established and usual elements that they already know from the machines in 
process visualization at the terminal. 

ADAPTATION TO CORPORATE DESIGN 

 

Illustrations can be adapted to the respective style requirements of the company, in order to achieve a 
consistent appearance through to the individual process screen. For example, the standard operation 
elements from zenon can be used, which can then be adapted to color worlds, house fonts and 
illustration styles of the corporate design. 
 

6.1.2 Referenced assemblies 

It is not just standard objects (rectangles, graphics, etc.) or effects (color gradients, animations, etc.) that 
can be displayed using the WPF elements, but also customized user controls (with logic in the code 
behind), which are referenced as assemblies.  

For example, a user control that looks like a tacho and provides special properties and optical effects can 
be created, such as a "Value" property, which causes the pointer of the tacho to move and/or the 
corresponding value to be displayed in a label. 

The workflow for this: 

 The appearance of a user controls is labeled with standard objects, which are offered by WPF.  

 The properties and interactions are programmed. 

 The whole package is compiled and present in the form of a .NET assembly. 
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This assembly can also be used for WPF projects. To do this, it must be referenced (linked) in the WPF 
editor (for example: Microsoft Expression Blend). To do this, select the assembly in the zenon file 
selection dialog: 

 

From this point in time, the WPF user controls of the assembly in the tool box can be selected under 
Custom user controls and used in the WPF project. 

See also, in relation to this, the following chapter: Guidelines for developers (à la page 96). 

USED REFERENCED ASSEMBLIES IN ZENON 

To use an assembly in zenon, this must be provided as a file.  
Collective files in .cdwpf format administer these independently; no further configuration is necessary. 
Assemblies must be added to the Files folder for .xaml files: 

 Click on Files on the project tree  

 Select Other 

 Select Add file... in the context menu 

 The configuration dialog opens  

 Insert the desired assembly 

When displaying a WPF file in the WPF element (Editor and Runtime), the assemblies from this folder 
are loaded. It is thus also ensured that that when the Runtime files are transferred using Remote 

Transport, all referenced assemblies are present on the target computer. 

A collective file (.cdwpf) can exist alongside an XAML file with the same name. All assemblies (*.dll) from 

all collective files and the Other folder are copied to the work folder. Only the highest file version is 
used if there are several assemblies with the same name. 

  Attention 

Assemblies are only removed after loading when the application is ended. This means:  

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is 
loaded is in the memory until zenon is ended, even if the screen is closed again. If you 

would like to remove an assembly from the Files/Other folder, the Editor must first 
be restarted, so that the assembly is removed.  

MULTI-PROJECT ADMINISTRATION 

With multi-project administration, the same assembly must be used in all projects. If an assembly is replaced 
by another version in a project, it must also be replaced in all other projects that are loaded in the Editor or in 
Runtime.  
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6.1.3 Workflows 

The WPF/XAML technology makes new workflows in process visualization possible. The separation of 
design and functionality ensures a clear distinction of roles between the project engineer and designers; 
design tasks can be easily fulfilled by using pre-existing designs, which no longer need to be modified by 
the project engineer. 

The following people are involved in the workflow to create WPF elements in zenon: 

 Designer 

 illustrates elements 

 takes care of the graphics for MS Expression Design 

 MS Expression Blend operator 

 Animates elements 

 Creates variables for the animation of WPF elements in zenon, which project engineer can 
access 

 Project engineer 

 Integrates elements into zenon: 

 stores logic and functionality 

We make a distinction: 

 Workflow with Microsoft Expression Blend (à la page 83) 

 Workflow with Adobe Illustrator (à la page 84) 

 
 

Workflow with Microsoft Expression Blend 

When using Microsoft Expression Blend, a WPF element is created in four stages: 

1. Illustration of elements in MS Expression Blend (à la page 85) 

2. Open element in MS Expression Design and export as WPF  

3. Animation in MS Expression Blend (à la page 85) 

4. Integration into zenon (à la page 170) 

You can find an example for creating a WPF elements with Microsoft Expression Blend in the Create 
button as XAML file with Microsoft Expression Blend (à la page 85) chapter. 
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Workflow with Adobe Illustrator 

Based on traditional design processes with Adobe Illustrator the following workflow is available: 

1. Illustration of elements in Adobe Illustrator (à la page 89) 

2. Import of .ai files and preparation in MS Expression Design (à la page 90) 

3. WPF export from MS Expression Design (à la page 90) 

4. Animation in MS Expression Blend (à la page 92) 

5. Integration into zenon (à la page 164)  

You can find an example for creation in the Workflow with Adobe Illustrator (à la page 88) chapter. 
 

6.2 Guidelines for designers 

This section informs you how to correctly create WPF files in Microsoft Expression Blend and Adobe 
Illustrator. The tutorials on Creating a button element (à la page 85) and a bar graph element (à la page 
88) show you how fully functional WPF files for zenon can be created from pre-existing graphics in a few 
steps. 

The following tools were used for this: 

 Adobe Illustrator CS3 (AI) 

 Microsoft Expression Design 4 (ED) 

 Microsoft Expression Blend 4 (EB) 

 zenon 

  Informations 

If referenced objects (assemblies) are used in WPF, note the instructions in the 
Referenced objects (à la page 81) chapter. 

 
 

6.2.1 Workflow with Microsoft Expression Blend 

With Microsoft Expression Blend, a WPF element: 

 is illustrated 

 is converted into WPF format using MS Expression Design  

 animated 
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The following example shows the illustration and conversion of a button element into an XAML file. 

Note: A test version of "Microsoft Expression Blend" can be downloaded from the Microsoft website. 
 

Create button as an XAML file with Microsoft Expression Blend  

CREATE BUTTON 

1. Start Expression Blend 

2. select the New Project option 

 

3. Select WPF as project type 



WPF element 

 

 

86 

 

 

4. give it a path and name of your choice (MyBlendProject, for example) 

 

The Language and Version settings can be ignored, because no functionality is to be 
programmed. 

5. After the dialog has been confirmed with OK, Microsoft Blend creates a new project with the 
chosen settings. Expression Blend adds an empty XAML file which already contains a class 
reference. 

6. Delete the CS file that belongs to the XAML file using the context menu. 

7. Rename the XAML file MainControl.xaml to MyButton.xaml. 

8. The development size of the file is set at 640 x 480 pixels as standard and must still be changed: 

a) switch to XAML view 

b) correct the size to 100 x 100 pixels 

c) Delete the class reference x:Class="MyBlendProject.MyButton" 
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9. switch to Design view 

 

10. add a button via the toolbar 

11. define the properties 

 Width: 50 

 Height: 50 

 Margins: 25 

 

The button is therefore at the center of the control. 

 

12. Save the changes and open the file in Internet Explorer to check it. You will see that the button is 
displayed in a size of 50 x 50 pixels. 

MAKE BUTTON SCALABLE 

If you integrate this status into zenon, the button will always have the exact size of 50 x 50 pixels. 
Because the button can be implemented as a scalable button, switch to Expression Blend again: 
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1. select the button in the tree view 

2. select the Group Into->Viewbox button in the context menu  

3. the button is inserted into a Viewbox 

4. Define the properties of the viewbox 

 Width: Auto 

 Height: Auto 

5. save the file 

 

6. If you now open the file in Internet Explorer, the button is automatically scaled when the IE 
window size is changed. This file will now also automatically adapt to changes in the size of the 
WPF element in zenon. 

CHANGE NAME 

Before you can integrate the file into zenon, you must give the WPF element a name. The WPF elements 
are not named in Expression Blend as standard, and are labeled with square brackets and their type. 
zenon content is assigned to WPF content via the name of the WPF elements: 

 in tree view, change the name 

 of the button on MyButton 

 of the ViewBox to MyViewBox 

This button can now be integrated in zenon (à la page 170) as an XAML file. 
 

6.2.2 Workflow with Adobe Illustrator 

When Adobe Illustrator is used, a WPF element: 
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 is illustrated in Adobe Illustrator 

 is converted into a WPF in MS Expression Design 

 is animated in MS Expression Blend 

The following example shows the illustration and conversion of a bar graph element into an XAML file. 
 

Bar graph illustration 

A bar graph is created in Adobe Illustrator. 

1. AI: Starting element for bar graph 

 

Illustrated in Adobe Illustrator CS3. 

2. AI: Path view of bar graph in Adobe Illustrator 

 

 All effects must be converted (Object -> Convert appearance) 

 All lines are transformed into paths (Object -> Path -> Contour line) 

 Do not use filters such as shading, blurring etc. 

NOTES ON COMPATIBILITY 

Illustrations that were created with Adobe Illustrator are in principle suitable for WPF export. However, 
not all Illustrator effects can become corresponding effects in Expression Design/Blend. Note: 
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Effect Description 

Clipping masks Clipping masks created in Adobe Illustrator are not correctly interpreted 
by Expression Design. These are usually shown in Blend as areas of black 
color. 

We recommend creating illustrations without clipping masks. 

Filters and effects Not all Adobe Illustrator filters are transferred into Expression Design 
accordingly:  Thus blurring filters, shading filters and corner effects from 
Illustrator do not work in Expression Design. 

Solution: 

  Most effects can be converted so that they can be read correctly by 
Expression Design using the Object -> Convert appearance 
command in Adobe Illustrator. 

 Corner effects from Adobe Illustrator are correctly interpreted by MS 
Design if they are converted to AI in paths. 

Text fields To be able to link text fields with code, these must be created separately 
in Expression Blend. "Labels" are required for dynamic texts; simple 
"text fields" are sufficient for static information. 

There is no possibility to create text labels in MS Design. These must be 
directly created in MS Blend. 

Transparencies and group 

transparencies 
There can be difficulties in Adobe Illustrator with the correct 
interpretation of transparency settings, in particular from group 
transparency settings. 

However MS Expression Blend and MS Expression Design do offer the 
possibility to create new transparency settings. 

Multiply levels These level settings in Adobe Illustrator are not always correctly 
displayed by MS Expression Blend. 

However, there is the possibility to "Multiply levels" directly in 
Expression Design. 

Indicating instruments and 

standard positions 
To prepare the graphics optimally for animation, the indicator and slider 

must always be set to the starting position, usually 0 or 12:00  

o'clock. 

Thus the position parameters for rotations etc. are also correct in Blend 
and an animation can be implemented without conversion of position 
data. 

 
 

WPF export 

WPF files are required for animation in Microsoft Expression Blend. We recommend Microsoft 
Expression Design for this export, because it provides good results and most Illustrator effects are 
correctly interpreted. 
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Note: There is a free plug-in for the direct export of WPF files from Adobe Illustrator available on the 
internet. This plug-in provides a quick, uncomplicated way of exporting from Illustrator, however it is 
less suited to the current application because it lead to graphical losses. Even color deviations from the 
original document are possible. 

Files in .ai format can regularly be imported into Expression Design; the paths are retained in the 
process. 
Attention: Some common Illustrator effects cannot be displayed by Expression Design correctly however 
(see Illustration (à la page 89) chapter). 

We export the pre-created bar graph element in 5 stages: 

1. ED: Import 

 Import the prepared Illustrator file (à la page 89) in Microsoft Expression Design via File -> 

Import 

2. ED: Optimization 

 

 If the starting file is not correctly displayed in MS Expression Design, it can still be 
subsequently edited and optimized here 

3. ED: Select 

 

 Highlight the element for WPF export with the direct selection arrow in MS Expression 
Design; in this case it is the whole clock 
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4. ED: Start export 

 

 Start the export via File -> Export 

 the dialog for configuring the export settings opens 

5. ED: Export settings 

 

 Enter the following export settings: 

a) Format: XAML Silverlight 4 / WPF Canvas 

Always name objects: Activate with tick 

Place the grouped object in an XAML layout container: Activate with tick 

b) Text: Editable text block 

c) Line effects: Rasterize all 

The exported file has .xaml file suffix. It is prepared and animated (à la page 92) in MS Expression Blend 
in the next stage. 
 

Animation in Blend 

With MS Expression Blend:  

 static XAML files from MS Expression Design are animated 

 Variables for controlling effects that can be addressed by zenon are created 

In thirteen steps, we go from a static XAML to an animated element, that can be embedded in zenon: 

1. EB:create project 
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a) Open Microsoft Expression Blend 

b) Create a new project  

c) Select the Project type of WPF- >WPF Control Library 

d) Give it a name (in our tutorial: My_Project) 

e) Select a location where it is to be saved 

f) Select a language (in our tutorial: C#) 

g) Select Framework Version 3.5 

2. EB: delete MainControl.xaml.cs 

 

a) Navigate to MainControl.xaml.cs 

b) Delete this file using the Delete command in the context menu 

3. EB: Open exported XAML file 

 

a) Open the context menu for My_Project (right mouse button) 

b) Select Add existing element… 

c) Select the XAML file exported from Microsoft Expression Design, in order to open this in 
Microsoft Expression Blend 

4. EB: Open MainControl.xaml 

 

a) Open the automatically created MainControl.xaml 

b) In the Objects and Time axes area, navigate to the UserControl entry 

5. EB: Adapt XAML code 
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a) Click on UserControl with the right mouse button 

b) Select Display XAML  in the contextual menu. 

c) Delete lines 7 and 9 in the XAML code: 

x:Class="My_Project.MainControl" 

d:DesignWidth="640" d:DesignHeight="480" 

6. EB: check XAML code 

 

 The XAML code should now look like this: 

<UserControl 

xmlns=http://schemas.microsoft.com/winfx/2006/xaml/presentation 
xmlns:x=http://schemas.microsoft.com/winfx/2006/xaml 
xmlns:d=http://schemas.microsoft.com/expression/blend/2008 
xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006" 

 

mc:Ignorable="d" 
x:Name="UserControl"> 

 

<Grid x:Name="LayoutRoot"/> 

</UserControl> 

7. EB: Copy elements 

 

a) Open the XAML file imported from Expression Design 

b) Mark all elements 

c) Select Delete in the context menu  

d) Change back to the automatically created XAML file 

8. EB: Insert element  

 

a) Click on Layout Root with the right mouse button 

b) Select Insert 
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9. EB: Adapt layout type  

 

a) Click on Layout root -> Change layout type -> Viewbox with the right mouse button 

b) The structure should now look like this: UserControl -> LayoutRoot -> Grid -> Elements 

c) Give a name for LayoutRoot and Grid by double-clicking on the names 

10. EB: Texts and values  

 

 Dynamic and static texts are labeled with text fields 

 Values (numbers) are issued with Labels  

11. EB: Insert labels  

 

 Labels replace numbers that are to be subsequently linked using INT variables (must be 
carried out for all number elements) 

12. EB: Set property 

 

 To display 100%, set the bar graph element's MaxHeight property to 341 (the maximum 
height of the indicator element is 340) 

13. EB: prepare for use in zenon  

 

a) Delete all name labels (names may only be given for elements that are to be addressed via 
zenon) 
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b) Save the XAML file with any desired name 

c) Integrate the XAML file into zenon (à la page 164) 

A tip for checking: If the XAML file is displayed with no problems in Microsoft Internet Explorer and the 
window size of Internet Explorer adapts to it, it will also be correctly used in zenon. 
 

6.3 Guidelines for developers 

This section handles the creation of simple WPF user controls with code-behind functionality using 
Microsoft Visual Studio and debugging this user control in Runtime.  

The following tools were used for this: 

 Microsoft Visual Studio 2015 

 zenon  

  Informations 

A Microsoft Visual Studio version from 2012 is recommended, due to the 
better-integrated XAML designer. 

 
 

6.3.1 Creation of a simple WPF user control with code behind function 

The creation and incorporation of a simple user control is described in this chapter. Because only the 
fundamental mechanisms/process for integration into zenon is described, the functionality of the user 
control is limited to the addition of two values. There is intentionally no enhanced error handling or 
explicit completion, in order to retain the simplicity of this example. 

CREATE WPF USER CONTROL 

1. Create a new Solution and a WPF User Control Library in this in Visual Studio. 

The .NET framework version 4 was selected for this example. A different version can also be 
selected, which must be installed on the target system on which Runtime will subsequently be 
started. 

Info: If the corresponding project template does not appear in the list of available templates, 
this can be added by means of the search (field at the top right of the dialog). 
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In our example, the project is given the name WPFUserControlLibrary. 

2. Create 3 text boxes and a button in the UserControl1.xaml file: 

 

3. Add the following code in the click event of the button: 
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Now you have the user control with the required functionality available. However, because zenon can 
only display XAML files that do not link to a code-behind file, an additional XAML file is needed that 
references the library (assembly) that has just been built.  

CREATION OF THE XAML FILE (WITHOUT CODE BEHIND) FOR ZENON 

Proceed as follows to create the XAML file required in zenon. 

1. Create a further project, again as a WPF User Control Library  

2. It was called WPFUserControlNoCodeBehind in our example. 

3. Insert a reference to the project that has just been built into this new project. 

 

4. The XAML files (UserControl1.xaml) looks as follows: 

 

5. Because all necessary content is contained in the DLL that has been created and no code-behind 
file can be used, delete the following lines: 

x:Class="WPFUserControlNoCodeBehind.UserControl1" 

xmlns:local="clr-namespace:WPFUserControlNoCodeBehind" 

6. Also delete (for the designer's size setting) the following lines: 

mc:Ignorable="d"  

d:DesignHeight="300" d:DesignWidth="300" 

7. Delete the code-behind file (UserControl1.xaml.cs) in this project. 
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8. Drag the user control that has been created beforehand (for the project 
WPFUserControlLibrary) over the toolbox in the XAML designer. 

9. Assign a name for the grid and the user control. 

Attention: If no name is given here, these elements do not appear in the linking dialog in the 
zenon Editor and thus cannot be made dynamic. 

10. The XAML file should now look as follows: 

 

In the next step, how the DLL and XAML file are incorporated into zenon is explained. 

STEPS IN ZENON 

1. Open the zenon Editor 

2. Go to File -> Graphics. 

3. Select Add file... in the context menu 

 

4. Select the XAML file at the save location (UserControl1.xaml from the 
WPFUserControlNoCodeBehind project) and add this: 

 

5. Insert the DLL with the functionality for the XAML file.  

To do this: 
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a) Select, in the context menu, File -> OtherAdd file.... 

b) Select the file WPFUserControlLibrary.dll (from the output path) of the first project 
(WPFUserControlLibrary). 

 

6. Create a  zenon screen. 

7. Add a WPF element and select the previously-incorporated XAML file.  

You should now see the following in the zenon Editor: 

 

8. Start zenon Runtime in order to also test the control there. 

 

 

  Informations 

The XAML file and referenced assemblies can also be saved in complied form as a 

*.cdwpf file. Only one file thus need to be imported in the Editor (under Files -> 
Graphics). Further information on this can be found in the CDWPF files (collective 
files) (à la page 119) chapter. 

Hint: When developing a WPF user control, it is usually more practical to insert the 
XAML file and the referenced DLL(s) separately. This makes the replacement of the 
DLL and debugging easier. Further information on the topic of debugging in the 
Debugging the WPF user control in Runtime (à la page 101). 

 



WPF element 

 

 

101 

 

 

  Attention 

Assemblies are only removed after loading when the application is ended. This means:  

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is 
loaded is in the memory until zenon is ended, even if the screen is closed again. If you 

would like to remove an assembly from the Files/Other folder, the Editor must first 
be restarted, so that the assembly is removed.  

Further examples can be found in the Examples: Integration of WPF into zenon (à la page 164) chapter. 
 

6.3.2 Debugging the WPF user control in Runtime 

To debug the WPF user control in Runtime, proceed as follows. 

In this example, the control described in the Creation of a simple WPF user controls with code behind 
function (à la page 96) is used. 

DEBUGGING BY MEANS OF ATTACH TO PROCESS 

1. Ensure that zenon Runtime has been started and a screen with the WPF user control is open. 

Furthermore, ensure that the DLL that is currently being used corresponds to the build (Version) 
of the user control project (WPFUserControlLibrary). 

2. Set a breakpoint in the click event of the button in the Visual Studio project 

 

3. In Visual Studio, under Debug , select the Attach to Process menu item. 
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4. Select the zenon Runtime process 

 

5. Under Attach to, select either Automatic or the corresponding .NET framework version (v4.x in 
this case) 

 

6. Click on Attach. 
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7. Now trigger the breakpoint in which you enter values into the WPF control in zenon Runtime and 
click on the button 

 

 

 

DEBUG USING START EXTERNAL PROGRAM 

1. Ensure that zenon Runtime has been closed. 

2. Ensure that, in the zenon Editor, the project that contains the WPF user control has been set as 
the start project. 

3. Ensure that the user control project (WPFUserControlLibrary) is set as the start project in Visual 
Studio. 

 

4. In the project properties of the Visual Studio project, select under Debug, for Start action: Start 

external program  

5. For Start external program, select the path of the zenon Runtime application. 

6. Under Working Directory, select the \wpfcache folder of the Runtime files 
(...\PROJECTNAME\RT\FILES\zenon\custom\wpfcache) 
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Hint: In the selected project in the zenon Editor, press the keyboard combination CTRL+ALT+R 
in order to jump directly to the root directory of the Runtime files. 

 

7. In the project properties, enter \wpfache folder of the Runtime files as the output path under 
Build 

 

8. Create the project in Visual Studio 

9. Start debugging in Visual Studio with Start 

 

10. zenon Runtime is now started automatically. 

11. Trigger the breakpoint by entering values in the WPF control in zenon Runtime and click on the 
button 
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  Informations 

When starting zenon Runtime, the assemblies (DLLs) referenced in the WPF user 
controls from the \FILES\zenon\custom\additional folder, and/or the assemblies 
from CDWPF files in the \FILES\zenon\custom\wpfcache folder are copied. If the file 
version of the DLL in the \wpfache folder is one higher than the version of the 
"original file", it is not replaced! 

For debugging, it is thus sufficient to only replace the file that is on the \wpfache 
folder directly.  

For delivery, it must be ensured that the current version of the DLL is present in the 
\additonal folder or the CDWPF file! 

Attention: If only the DLL is updated in the \additional folder or in the CDWPF, but 
the version number is not increased, the DLL must be deleted manually in the 
\wpcache folder, because it is not updated otherwise (due to the above-described 
mechanism). 

 

 

  Attention 

Assemblies are only removed after loading when the application is ended. This means:  

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is 
loaded is in the memory until zenon is ended, even if the screen is closed again. If you 

would like to remove an assembly from the Files/Other folder, the Editor must first 
be restarted, so that the assembly is removed.  

 
 

6.3.3 Data exchange between zenon and WPF user controls 

There are different possibilities for exchanging data between zenon and WPF user controls. 

 Data exchange using dependency properties (à la page 105) 

 Data replacement via VSTA (à la page 109) 
 

Data exchange using dependency properties 

The most elegant and secure way to exchange data between zenon and self-created WPF user controls 
is by using dependency properties. 
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The WPF user control project created in the Creating a simple WPF user controls with code behind 
function (à la page 96) serves as a basis (WPFUserControlLibrary).  

In this chapter too, the focus is purely on the core theme (dependency properties and data exchange 
between the user control and zenon in this case). Specific WPF features such as data connection, etc., as 
well as explicit error handling, are not covered. 

ADDITIONS TO THE CODE 

1. Create the TextChanged Event for the textBoxA element in the UserControl1.xaml file  

TextChanged="textBoxA_TextChanged" 

2. Add the following lines of code in the UserControl1 class of the code behind file 
(UserControl1.xaml.cs)  

    /// <summary> 

    /// Gets or sets the ValueA. 

    /// </summary>   

    public double ValueA 

    { 

      get 

      { 

        return (double)GetValue(ValueADependencyProperty); 

      } 

      set 

      { 

        SetValue(ValueADependencyProperty, value); 

      } 

    } 

 

    /// <summary> 

    /// Dependency property for ValueA 

    /// </summary> 

    public static readonly DependencyProperty ValueADependencyProperty = 

         DependencyProperty.Register("ValueA", typeof(double), 

         typeof(UserControl1), new FrameworkPropertyMetadata(0.0, new 

PropertyChangedCallback(OnValueADependencyPropertyChanged))); 

 

    /// <summary> 

    /// Called when [value a dependency property changed]. 

    /// </summary> 

    /// <param name="source">The source.</param> 
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    /// <param name="e">The <see cref="DependencyPropertyChangedEventArgs"/> instance 

containing the event data.</param> 

    private static void OnValueADependencyPropertyChanged(DependencyObject source, 

DependencyPropertyChangedEventArgs e) 

    { 

      UserControl1 control = source as UserControl1; 

      if (control != null) 

      { 

        try 

        { 

          control.ValueA = (double)e.NewValue; 

          control.textBoxA.Text = control.ValueA.ToString(); 

        } 

        catch (Exception)  

        {} 

      } 

    } 

 

    /// <summary> 

    /// Handles the TextChanged event of the textBoxA control. 

    /// </summary> 

    /// <param name="sender">The source of the event.</param> 

    /// <param name="e">The <see cref="TextChangedEventArgs"/> instance containing the 

event data.</param> 

    private void textBoxA_TextChanged(object sender, TextChangedEventArgs e) 

    { 

      try 

      { 

        ValueA = Convert.ToDouble(textBoxA.Text); 

      } 

      catch (Exception) 

      {} 

    } 

 

Then build the solution. 
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  Informations 

A numerical property (double) is used in this example. Other simple data types (such 
as bool, string, int, etc.) can also be used.  

LINKING IN ZENON 

1. Update the WPF user control (DLL) in the zenon Editor. 

To do this, proceed as described in the Creating a simple WPF user controls with code behind 
function (à la page 96) and note that, under certain circumstances, the zenon Editor must be 
restarted if another version of the assembly (DLL) has been loaded by the Editor. 

2. Create a numeric variable in zenon and link it to a dynamic text element in the screen next to the 
WPF element with your user control. 

3. Open the screen that contains the WPF element and select, for the WPF element, under WPF 

links: Configuration 

 

4. Expand the node in the tree at the top left and select AdditionControl 

 

5. Select the line with ValueA (this is the name of the property that was created in the code 
beforehand) and select, for Type of link:, Variable. 
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Hint: Give Properties a prefix so that this can be found more easily, for example: _ValueA 

6. In the column under Linkage, print out the variable that was created in zenon beforehand 

 

7. Confirm the dialog with OK and build the Runtime files 

8. Start Runtime in order to test the WPF user control 

 

9. If the value is changed in user control, the value automatically changes in zenon and vice versa. 

10. Of course you can debug the control as described in the Debugging the WPF user control in 
Runtime (à la page 101) chapter, as well as create further dependency properties. 

  Informations 

The UserControl_Loaded event can be used in order to (automatically) access the 
values of the dependency property during initialization (when calling up the user control) 
for example.  

 
 

Data replacement via VSTA 

Data can also be exchanged between zenon and WPF user controls using VSTA.  

The API element methods   

 get_WPFProperty (reading of values) 

 set_WPFProperty (writing of values) 

are used for this. 

The example used here is based on the example used in the Data exchange using dependency properties 
(à la page 105) chapter. 
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CREATION OF A VSTA MACRO FOR DATA EXCHANGE BETWEEN ZENON AND THE WPF 
USER CONTROL 

1. Create the following VSTA macro in the project add-in of the zenon project 

 

Whereby: 

 "Screen" is the name of the zenon screen in which the WPF element is located 

 "WPF_Element" is the name of the WPF element that contains the WPF user control 

 "AdditionControl" is the name of the WPF user controls itself (defined in the 
(UserControl1.xaml file) 

 "ValueA" is the name of the user control property 

2. Create an execute VSTA macro function and link this to a button in the screen in which the WPF 
element is also located 

3. Start Runtime to test changes 

 

When executing the macro, the value is read by the control, doubled and written back. 

  Informations 

The user control properties used for this method of data exchange need not necessarily 
be dependency properties, as outlined in this example. "Standard" properties can also be 
used, see in relation to this the Access via VSTA "variable link" (à la page 111) chapter. 
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6.3.4 Access to the zenon (Runtime) object model from a WPF user control 

There are different possibilities for access to the zenon object model from a WPF user control. This is 
explained in more detail in the following chapters. 
 

Access via VSTA "variable link" 

In order to get access to the zenon Runtime COM interface by means of "variable link", proceed as 
follows. The creation of a simple WPF user controls with code behind function (à la page 96) serves as an 
initial example. 

  Informations 

The following code is intended to show an example of how the COM implements 
access to zenon Runtime and in doing so limits itself to the basic functionality. There 
is no explicit error handling, etc. 

NECESSARY AMENDMENTS IN WPF USER CONTROL 

The following steps are necessary in the WPF user control project (WPFUserControlLibrary). 

Firstly, a reference to the zenon COM interface must be incorporated. 

 

 

After this, the following code must be inserted in the UserControl1 class: 

 

//The zenon Project 

zenOn.Project zenonProject = null; 
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/// <summary> 

/// Property for the Variable link via VSTA 

/// </summary> 

public object zenonVariableLink 

{ 

  get { return null; } 

  set 

  {     

    if (value != null && zenonProject == null) 

    { 

      zenOn.Variable zenonVariable; 

      try 

      { 

        zenonVariable = (zenOn.Variable)value; 

      } 

      catch (Exception) 

      { 

        return; 

      } 

      if ((zenonVariable!= null) && (!string.IsNullOrEmpty(zenonVariable.Name))) 

      { 

        zenonProject = zenonVariable.Parent.Parent; 

      } 

    } 

  } 

} 

 

/// <summary> 

/// Trigger used to notify the control from VSTA to release the COM resources 

/// </summary> 

public object zenonReleaseTrigger 

{ 

  get { return null; } 

  set 

  { 

    if ((bool)value && zenonProject != null) 

    { 

      try 

      { 
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        Marshal.FinalReleaseComObject(zenonProject); 

      } 

      catch (Exception) 

      { 

        return; 

      } 

      zenonProject = null; 

      GC.Collect(); 

      GC.WaitForPendingFinalizers(); 

      GC.Collect(); 

    } 

  } 

} 

 

Whereby access to the properties zenonVariableLink (to initialize the COM object) and 
zenonReleaseTrigger (to unlock the COM object) are subsequently accessed from VSTA (write). 

In order to test the COM access quickly very easily, it is possible to insert the following line of code in 
the existing button-click event of the user control. 

private void buttonAdd_Click(object sender, RoutedEventArgs e) 

{ 

  if (zenonProject != null) 

  { 

    MessageBox.Show(zenonProject.Name); 

  } 

  return; 

  ... 

 

  Informations 

A zenOn.Project variable is used in this example. Of course other objects such as 
events, etc. of the zenon object model can also be used. 

NECESSARY AMENDMENTS IN THE ZENON PROJECT/VSTA CODE 

The following steps are necessary in the VSTA code: 

Creation of a VSTA macro for the initialization 

/// <summary> 
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/// Macro for API initialization in the WPF User Control 

/// </summary> 

public void MacroWPFInit() 

{ 

  zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen"); 

  zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element"); 

  myWPFElement.set_WPFProperty("AdditionControl", "zenonVariableLink", 

this.Variables().Item(0));  

} 

 

Creation of a VSTA macro for approval 

/// <summary> 

/// Macro for API release in the WPF User Control 

/// </summary> 

public void MacroWPFRelease() 

{   

  zenOn.IDynPicture myWPFScreen = this.DynPictures().Item("Screen"); 

  zenOn.IElement myWPFElement = myWPFScreen.Elements().Item("WPF_Element"); 

  myWPFElement.set_WPFProperty("AdditionControl", "zenonReleaseTrigger", true); 

} 

 

Create two execute VSTA macro functions that are linked with buttons, which are in the same screen as 
the WPF element. 

Now start Runtime in order to test the functionality 

 Execute the macro for initialization 
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 Click on the button in the WPF user control; a message box with the project name of the project 
appears 

 

 Execute the macro for release 

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user 
control in Runtime (à la page 101). 

  Conseil 

The initialization and release of the COM object in this example is only carried out for 
simple demonstration using VSTA macro functions. Depending on the application, and/or 
in practice, events in VSTA are better suited to this.  

For example, the code for initialization in the _Open event of the screen can be executed 
with the WPF element and the code for release in the _Close event. 

The mechanism described here is also used in the Display of WPF elements in the zenon 
Web Client (à la page 160) chapter. 

 

  Attention 

If COM objects are used in WPF user controls, these must always be explicitly approved 
before destroying the WPF user control (before closing the screen, before closing 
Runtime, before reloading). 

 
 

Access via marshaling 

In order to get access to the zenon Runtime COM interface by means of marshaling, proceed as follows. 
The creation of a simple WPF user controls with code behind function (à la page 96) serves as an initial 
example. 
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  Informations 

The following code is intended to show an example of how the COM implements 
access to zenon Runtime and in doing so limits itself to the basic functionality. There 
is no explicit error handling, etc. 

NECESSARY AMENDMENTS IN WPF USER CONTROL 

The following steps are necessary in the WPF user control project (WPFUserControlLibrary). 

Firstly, a reference to the zenon COM interface must be incorporated. 

 

 

After this, the following code must be inserted in the UserControl1 class: 

//The zenon Project 

zenOn.Project zenonProject = null; 

 

Furthermore, the constructor of the user controls must be supplemented with the lines below (to 
initialize the COM object): 

/// <summary> 

/// Constructor for UserControl1, initialize COM Object 

/// </summary>  

public UserControl1() 

{ 

  InitializeComponent(); 

 

  try 

  {        
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    zenonProject = 

((zenOn.Application)Marshal.GetActiveObject("zenOn.Application")).Projects().Item("TES

TPROJECT"); 

  } 

  catch (Exception) 

  {  

  }       

} 

 

The COM object must be approved in the UserControl_Unloaded event: 

/// <summary> 

/// Release COM Object 

/// </summary>  

private void UserControl_Unloaded(object sender, RoutedEventArgs e) 

{ 

  try 

  { 

    if (zenonProject != null) 

    { 

      Marshal.FinalReleaseComObject(zenonProject); 

      zenonProject = null; 

    } 

  } 

  catch (Exception) 

  {  

  } 

} 

 

In order to test the COM access quickly very easily, it is possible to insert the following line of code in 
the existing button click event of the user control. 

private void buttonAdd_Click(object sender, RoutedEventArgs e) 

{ 

  if (zenonProject != null) 

  { 

    MessageBox.Show(zenonProject.Name); 

  } 

  return; 
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  ... 

 

Now build the solution and update the WPF user control in the zenon project. 

Start Runtime to test the user control. 

 

In order to debug the user control, it is possible to proceed as described in the Debugging the WPF user 
control in Runtime (à la page 101). 

  Informations 

A zenOn.Project variable is used in this example. Of course other objects such as 
events, etc. of the zenon object model can also be used. 

 

  Attention 

If COM objects are used in WPF user controls, these must always be explicitly approved 
before destroying the WPF user control (before closing the screen, before closing 
Runtime, before reloading). 

 

  Informations 

No access by means of marshaling is possible in the zenon web client. If access to the 
COM interface is required there, the method described in the Access via VSTA "variable 
link" (à la page 111) must be used. 

 
 



WPF element 

 

 

119 

 

 

6.4 Engineering in zenon 

In order to be able to use WPF user controls in zenon, version 3.5 (or higher, depending on the .NET 
framework version used in the user control) of the Microsoft framework must be used on both the 
Editor computer and the Runtime computer. 

CONDITIONS FOR THE WPF DISPLAY IN ZENON 

The dynamization is currently available for simple variable types (numerical data types as well as string). 
Arrays and structures cannot be dynamized.  

Therefore the following WPF functions can be implemented in zenon: 

 Element properties that correspond to simple data types, such as SString, Int, Double, 
Bool etc. 

 Element properties of the "Object" type, which can be set with simple data types 

 Element events can be used with functions; the parameters of the events are not however 
available in and cannot be evaluated in zenon 

 Element transformation, for which a RenderTransform is present for the element in the XAML 
file 

Attention: if the content is outside of the area of the WPF element during transformation, this is 
not labeled 

Notes on dBase: No shade can be displayed in zenon for WPF elements.  

  Attention 

If the Runtime files were created for a project for a version before 6.50, existing WPF 

elements are not included into Runtime screens. 

 
 

6.4.1 CDWPF files (collective files) 

A CDWPF file (with the suffix *.cdwpf) is an renamed ZIP file that contains the following components: 

 XAML file (to reference the user control assembly) 

 DLL file (the actual WPF user control, optional) 

 Preview graphics (for preview, optional) 

 

Rules for the use of collective files: 
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 The files (XAML, DLL, preview graphics) can be in the CDWPF file directly or in a joint folder.  

 The name of the collective file should correspond to the names of the XAML file. 

 Only one XAML file may be contained.  

 The preview graphic should be small and no more than 64 pixels high.  
Name of the preview file: preview.png or the name of the XAML file with the suffix png.  

 Any number of assemblies can be used. The distinction is made on the basis of the file version.  

 Collective files do not need to contain an assembly. 

 All subfolders are examined and only taken into account with *.dll, *.xaml or *.png files. 

 If a collective file (*.cdwpf) is replaced by a file with a different version, all corresponding CDWPF 
files in all symbols and images in all projects must be adapted. 

 

6.4.2 create WPF element 

To create a WPF element 

1. In the elements toolbar, select the symbol for WPF element or the Elements entry in the menu 

2. Select the start point in the main window.  

3. Pull open the element with the mouse.  

4. In properties, select Affichage the property Fichier XAML in the group. 

5. The file selection dialog opens.  

6. Select the desired file 
Files of the following formats are valid: 

 *.xaml: Extensible Application Markup Language 

 *.cdwpf: WPF collective file, also shows preview image 

(The file must already be present in the Project Manager under Files/graphics or created in the 
dialog.) 

7. Configure the links (à la page 121). 

  Informations 

If referenced assemblies are used, note the instructions in the Referenced assemblies (à 
la page 81) chapter. 

 
 



WPF element 

 

 

121 

 

 

6.4.3 Configuration of the linking 

To configure a WPF element 

1. In properties, select Liens WPF the property Configuration in the group. 

2. The dialog with three tabs opens with a preview of the XAML file and the elements present in 
the file 

DIALOG CONFIGURATION 
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Parameters Description 

Available elements Shows the named file elements in a tree structure. The 
selected element can be linked with process data.  

WPF is assigned to process data based on the element 
name. Therefore elements are only shown if they and the 
attendant elements have a name.  Allocations are 
configured and shown in the Properties, Events, 
Transformations tabs. 

Hint: If the corresponding elements are not displayed, 
check in the XAML file to see if this has a name (for 

example: <Grid  Name="GridName">). 

Preview The selected element is shown flashing in the preview. 

Properties (à la page 123) Configuration and display of properties (variables, 
authorizations, interlockings, linked values). 

Events (à la page 129) Configuration and display of events (functions). 

Transformations (à la page 130) Configuration and display of transformations. 

Name Name of the property. 

Connection Selection of link. 

Link type Type of link (variable, authorization, function) 

WPF info Shows the current value for properties in WPF content. For 
the user, it is directly visible what type of property it is 
(Boolean, string, etc.). 

Linked Shows if a property is currently being used. 

Not contained by default in the view, but can be selected 
using Context menu->Column selection. 

  Informations 

Only logical objects can be displayed in the configuration dialog. Visual objects are not 
displayed. You can read about backgrounds and how visual objects can be animated in 
the Allocation of zenon object to WPF content. 

EDIT HYPERLINKS 

All configured hyperlinks can be edited from the properties of the element. Click on the element and 
open the property group Liens WPF. Hyperlinks can be further configured here, without having to open 
the dialog. 

Limitations : 

 Le type de liaison ne peut pas être modifié ici. 

 Les nouveaux liens peuvent uniquement être créés via la boîte de dialogue de configuration. 
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 Insertion d'un élément WPF dans un symbole : Les liens WPF ne peuvent pas être exportés. 

 
 

Properties 

The properties enable the linking of:  

 Variables (à la page 125) 

 Values (à la page 126) 

 Authorizations and interlockings (à la page 127) 
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Parameters Description 

Name Name of the property. 

Connection Linked variable, authorization or linked value.  

Clicking in the column opens the respective selection 
dialog, depending on the entry in the Link type column.  

Link type Selection of linking.  

WPF info Shows the current value for properties in WPF content. 
For the user, it is directly visible what type of property it is 
(Boolean, string, etc.). 

Linked Shows if a property is currently being used.  

Not contained by default in the view, but can be selected 
using Context menu->Column selection. 

CREATE LINK 

To create a link: 

1. Highlight the line with the property that is to be linked 

2. Click in the Link type cell 

3. Select the desired link from the drop-down list. 

The following are available: 

 <not linked> (deletes an existing link) 

 Authorization/Interlocking 

 Constant value 

 Variable 

4. Click in the Link cell  

5. The dialog for configuring the desired link opens 

  Informations 

Properties of WPF and zenon can be different. If, for example the visibility property is 
linked, there are three values available in .NET: 

0 - visible 

1 - invisible  

2- collapsed 

These values must be displayed via the linked zenon variable. 
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Link variable 

To link a variable with a WPF property: 

1. Highlight the line with the property that is to be linked 

2. Click in the Link type cell  

3. Select from the variable drop down list  

4. Click in the Link cell  

5. The dialog for configuring the variables opens 

This dialog also applies for the selection of variables with transformations (à la page 130). The 
configuration also makes it possible to convert from zenon into WPF units. 
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Parameters Description 

Linked variables Selection of the variable to be linked. A click on the ... 
button opens the selection dialog. 

Value range of WPF element Data to convert variable values into WPF values. 

Convert value range Active: WPF unit conversion is switched on.  

Effect on Runtime: The current zenon value (incl. 
zenon unit) is converted to the WPF range using 
standardized minimum and maximum values. 

For example: The value of a variable varies from 
100 to 200. With the variables, the standardized 
range is set to 100 - 200. The aim is to display this 
change in value using a WPF rotary knob. For this: 

 for Transformations, the RotateTransform.Angle 
property is linked to the variables 

 Adjust value activated  

 a WPF value range of 0 to 360 is configured 

Now the rotary knob can be turned at a value of 
150, for example, by 180 degrees. 

Minimum Defines the lowest WPF value.  

Maximum Defines the highest WPF value. 

OK Accepts settings and ends the dialog. 

Cancel Discards settings and ends the dialog. 

Help Opens online help. 

 
 

Link values  

Linked values can either be a String or a numerical value of the type Double. When selecting the screen, 
the selected value is sent in WPF content after loading the WPF content. 

To link a value with a WPF property: 

1. Highlight the line with the property that is to be linked 

2. Click in the Link type cell 

3. Select Value linkings from the drop-down list  

4. Click in the Link cell 
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5. The dialog for configuration of value linking opens 

 

Parameters Description 

Linked value: Entry of a numerical value or string value. 

Use string 
Active: A string value is used instead of a numerical value. 

The language of string values can be switched. The text is 
translated in Runtime when the screen is called up and sent in 
WPF content. If the language is switched whilst the screen is 
opened, the string value is retranslated and sent. 

String value/numerical value Depending on what is selected for the Use string property, a 
numerical value or a string value is entered into this field. For 
numerical values, a unit of measurement can also be selected. 

Unit: Selection of a unit of measurement from the drop down list. You must 
have configured this in unit switching beforehand. 

The unit of measurement is allocated with the numerical value. If 
the units are switched in Runtime, the value is converted to the 
new unit of measurement and sent to WPF content. 

OK Accepts settings and ends the dialog. 

Cancel Discards settings and ends the dialog. 

Help Opens online help. 

 
 

Link authorization or interlocking 

Authorizations cannot be granted for the whole WPF element. The element is allocated a user level. 
Authorizations are granted within the user level for individual controls. If an authorization is active, the 
value 1 is written to the element. 

To link an authorization or interlocking with a WPF property: 

1. Highlight the line with the property that is to be linked 
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2. Click in the Link type cell 

3. Select Authorization/interlocking from the drop down menu  

4. Click in the Link cell 

5. The dialog for configuring the authorizations opens 

 

Parameters Description 

Link authorization/interlocking Setting the authorizations. 

Linked status  Selection of an authorization that is linked to a WPF control from 
the drop down list. For example, visibility and operability of a 
WPF button can depend on a user's status. 

 

Authorization Description 

Authorization available If the user has sufficient rights to operate the WPF element, a value of 1 
is written to the property. 

Authorization does not 

exist 
If the user does not have sufficient rights to operate the WPF element, a 

value of 1 is written to the property. 

Not interlocked If the element is not locked, the value 1 is written to the property. 

Interlocked If the element is locked, the value 1 is written to the property. 

Can be operated If authorization is present and the element is not locked, then a value of 
1 is written to the property. 

Cannot be operated If authorization is not present or the element is not locked, then a value 

of 1 is written to the property. 
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Events 

Events make it possible to link zenon functions to a WPF element. 

 

Parameters Description 

Name Name of the property. 

Connection Linked function. Clicking in the cell opens the 
configuration dialog. 

Link type Selection of linking. Clicking in the cell opens the selection 
dialog. 

WPF info Shows the current value for properties in WPF content. 
For the user, it is directly visible what type of property it is 
(Boolean, string, etc.). 

Linked Shows if a property is currently being used.  

Not contained by default in the view, but can be selected 
using Context menu->Column selection. 

LINK FUNCTIONS 

To create a link: 

1. Highlight the line with the property that is to be linked 
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2. Click in the Link type cell 

3. Select from the drop down list function 

4. Click in the Link cell 

5. The dialog for configuring the function opens 

 

Parameters Description 

Linked function Selection of the function to be linked. Clicking on the ... 
button opens the dialog for Function selection. 

OK Accepts selection and closes dialog. 

Cancel Discards changes and closes dialog. 

Help Opens online help. 

 
 

Transformation 

The WPF element does not support rotation. If, for example, the WPF element is in a symbol and the 
symbol is rotated, the WPF element does not rotate with it. Therefore there is a different mechanism for 
Transformation with WPF to turn elements or to otherwise transform them. These transformations are 
configured in the Transformation tab. 
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Attention: If the content is outside of the WPF element area, this part of the contents is lost or it is not 
shown. 
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Parameters Description 

Name  Name of the property. 

Connection Selection of the linked variables.  

Transformations are displayed in XAML as transformation objects with their own 
properties. If an element supports a transformation, then the possible properties 
of the transformation object are displayed in list view. (more on this in: Integrate 
button as WPF XAML in zenon (à la page 170) 

For example, if the linked variable is set at the value of 10, then this value is 
written as a WPF target and the WPF element is rotated by 10°. 

Link type Selection of transformation link type. 

WPF info Shows the current value for properties in WPF content. For the user, it is directly 
visible what type of property it is (Boolean, string, etc.). 

Linked Shows if a property is currently being used.  

Not contained by default in the view, but can be selected using Context 

menu->Column selection. 

LINK TRANSFORMATIONS 

To link a transformation with a WPF property: 

1. Highlight the line with the property that is to be linked 

2. Click in the Link type cell 

3. Select from the Transformation drop down list  

4. Click in the Link cell 

5. The dialog for configuring the variables opens 

The configuration also makes it possible to convert from zenon into WPF units. 
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Parameters Description 

Linked variables Selection of the variable to be linked. A click on the ... 
button opens the selection dialog. 

Value range of WPF element Data to convert variable values into WPF values. 

Convert value range Active: WPF unit conversion is switched on.  

Effect on Runtime: The current zenon value (incl. 
zenon unit) is converted to the WPF range using 
standardized minimum and maximum values. 

For example: The value of a variable varies from 
100 to 200. With the variables, the standardized 
range is set to 100 - 200. The aim is to display this 
change in value using a WPF rotary knob. For this: 

 for Transformations, the RotateTransform.Angle 
property is linked to the variables 

 Adjust value activated  

 a WPF value range of 0 to 360 is configured 

Now the rotary knob can be turned at a value of 
150, for example, by 180 degrees. 

Minimum Defines the lowest WPF value.  

Maximum Defines the highest WPF value. 

OK Accepts settings and ends the dialog. 

Cancel Discards settings and ends the dialog. 

Help Opens online help. 

 
 

6.4.4 Validity of XAML Files 

XAML files are valid subject to certain requirements: 

 Correct name spaces 

 No class references 

 Scalability 

CORRECT NAME SPACE 

The WPF element can only display WPF content, i.e.: 
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Only XAML files with the correct WPF namespace can be displayed by the WPF element. Files that use a 
Silverlight namespace cannot be loaded or displayed. However, in most cases it is suffice to change the 
Silverlight namespace to the WPF namespace. 

WPF-Namespaces:  

xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"  

xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml" 

NO USE OF CLASS REFERENCES 

Because the XAML files can be loaded dynamically, it is not possible to use XAML files that contain 
references to classes ("class" key in header). Functions that have been programmed in 
independently-created C#- files cannot be used. 

In order to use WPF user controls with code behind, the process as described in the Creating a simple 
WPF user control with code behind funciton (à la page 96) must be carried out. 

SCALABILITY 

If the content of a WPF element is adjusted to the size of the WPF element, then the controls of the WPF 

element are interlaced in a control that offers this functionality, such as a view box for example. In 
addition, it must be ensured that the height and width for this elements are configured as automatic. 

CHECKING AN XAML FILE TO SEE IF IT IS CORRECT 

To check if an XAML file has the correct format: 

 Open XAML file in Internet Explorer 

 If it can be opened without additional plug-ins (Java or similar), then it can be assumed with 
a high degree of certainty that this file can be loaded or displayed by zenon 

 if problems occur during loading, these are then shown in Internet Explorer and the lines in 
which problems arise can be clearly seen 

The scaling can also be tested in this manner: If the file has been created correctly, the content will 
adjust to the size of the Internet Explorer window. 

ERROR MESSAGE 

If an invalid file is used in zenon, then an error message is displayed in the output window when loading 
the file in the WPF element. 

For example:  
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"error when loading 
xaml-Datei:C:\ProgramData\COPA-DATA\SQL\781b1352-59d0-437e-a173-08563c3142e9\

FILES\zenon\custom\media\UserControl1.xaml 

The attribute "Class" cannot be found in XML namespace 

"http://schemas.microsoft.com/winfx/2006/xaml". Line 7 Position 2." 
 

6.4.5 Pre-built elements 

zenon is already shipped with several WPF elements. More are available for download in the web shop.  

All WPF elements have properties which determine the graphical design of the respective element 
(Dependency Properties). Setting the values via an XAML file or linking the property via zenon can 
directly change the look in the Runtime. The tables in the description of the individual elements contain 
the respective Dependency Properties,  depending on the control. 

Available elements: 

 Analog clock (à la page 136) 

 Vertical bar graph (à la page 136) 

 Comtrade Viewer (à la page 137) 

 Energy class diagram (à la page 147) 

 Progress bar (à la page 137) 

 Pareto diagram (à la page 148) 

 Sankey diagram (à la page 155)  

 Round display (à la page 152) 

 Temperature control  (à la page 157) 

 Universal slider (à la page 158) 

 Waterfall diagram (à la page 159) 

REPLACING ASSEMBLY WITH A NEWER VERSION 

Per project only one assembly for a WPF element can be used in the zenon Editor as well as in the 
Runtime. If two versions of an assembly  are available in a project, then the first loaded file is used. A 
user enquiry is made as to which version should be used. No further actions are needed for the 
maintenance of the versions used up until now. If a newer version is chosen, all corresponding CDWPF 
files in all symbols and images in all projects must be adapted.  

Note for Multi-Project Administration: If an assembly in a project is replaced by a new version, it must 
also be replaced in all other projects that are loaded in the Editor or in Runtime.  
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Analog clock - AnalogClockControl 

Property Function Value 

ElementStyle Shape/type of element. Enum: 

 SmallNumbe
rs 

 BigNumbers 

 No 

ElementBackgroundBrush Color of element background. Brush 

ElementGlasReflection Activate the glass effect on the element. Visibility 

Offset Value in hours (h) which displays the time lag to the 
system clock. 

Int16 

OriginText Text which is displayed in the clock (e.g. location). String 

 
 

Bar graph vertical - VerticalBargraphControl 

Property Function Value 

CurrentValue Current value which should be displayed. Double 

MinValue Minimum value of the scale. Double 

MaxValue Maximum value of the scale. Double 

MajorTicksCount Number of main ticks on the scale. Integer 

MinorTicksCount Number of sub ticks on the scale. Integer 

MajorTickColor Color of main ticks on the scale. Color 

MinorTickColor Color of sub ticks on the scale. Color 

ElementBorderBrush Color of the element border. Brush 

ElementBackgroundBrush Color of element background. Brush 

ElementGlasReflection Activate the glass effect on the element. Visibility 

ElementFontFamily Element font. Font 

ScaleFontSize Font size of the scale. Double 

ScaleFontColor Font color of the scale. Color 

IndicatorBrush Bar graph fill color. Brush 

BargraphSeparation Number of bar graph dividion. Integer 

BargraphSeparationColor Color of the scale division. Color 
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Progress bar - ProgressBarControl 

Property Function Value 

CurrentValue Current value which should be displayed. Double 

MinValue Minimum value of the value area. Double 

MaxValue Maximum value of the value area. Double 

ProgressbarDivisionCount Number of divisions of the progress bar. Integer 

VisibilityText Visibility of the value display. Boolean 

TextSize Font size of the value display. Double 

TextColor Color of the value display. Color 

ProgressBarBoxedColor Color of the border of the progress bar. Color 

ProgressBarMarginDistance Distance of the progress bar box from the element edge (left, 
top, right, down). 

Double 

ProgressBarInactiveBrush Indicator color not active. Brush 

ProgressBarActiveBrush Indicator color active. Brush 

ProgressBarPadding Distance of the progress bar from the progress bar box (left, 
top, right, down). 

Double 

ElementBorderBrush Color of the element border. Brush 

ElementBackgroundBrush Color of element background. Brush 

 
 

COMTRADE-Viewer 

The COMTRADE-Viewer WPF element is available to partners of COPA-DATA and is available to these via 
the Partner Portal. 

It is for the graphical analysis of digital error and result logging of a COMTRADE file. 

  Informations 

The control supports IEEE C37.111 (IEEE Standard Common Format for Transient 
Data Exchange (COMTRADE) for Power Systems) standards-compliant files. ASCII or 
binary files in accordance with the 1999 or 2013 edition can be visualized.  

Older files or files without a year identification are not supported. This is displayed 
with a warning dialog in Runtime. 
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Possibilities of the COMTRADE-Viewer WPF control in zenon Runtime: 

 Selection of a file in the COMTRADE file format 

 Exports selected objects as an CSV file. 

 Visualization of the selected COMTRADE file: 
Note: The display colors can be configured in the zenon Editor. 

 Current (sinus wave display) 

 Voltage (sinus wave display) 

 Digital signals (binary bar chart display) 

 Display of values at a selected cursor position. 

 If an element that represents neither current or voltage is selected, (such as frequency), this 
is visualized in both analog areas again (current and voltage). 

 Navigation: 

 Zoom in and zoom out using the mouse wheel, scroll bar and Multi-Touch gestures 

 Enlargement of the area  
Selection of the area by clicking the mouse 

 Move the display area using the right mouse button, scroll bar or Multi-Touch gestures. 
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  Conseil 

To be able to transport COMTRADE files to the zenon Runtime computer, you can 
also use the file transfer of the IEC 61850 driver or the FTP function block of zenon 
Logic. 

You can find further information about this in the driver documentation of the IEC 
61850 driver or in the zenon Logic documentation. 

LICENSING 

The COMTRADE-Viewer can only be configured in the zenon Editor with a valid Energy Edition license. If 
there is no valid license, the WPF is displayed as grayed out in the Editor. A valid Energy Edition license is 
also required for display in Runtime. 

 
 

Display during Runtime 

The COMTRADE WPF element offers two views in Runtime: 

 Configuration view 

 Selection of a COMTRADE configuration file 

 Selection of the elements to be displayed 

 Graph view  

 Zoom in and zoom out 

 Display of values at a selected cursor position. 

 Export of the selected elements as an CSV file 

  Informations 

The switch between the views is integrated in the WPF element. Additional project 
configuration of a screen switching function is not necessary. 

 
 



WPF element 

 

 

140 

 

 

Runtime view - configuration page 

If a screen with a configured COMTRADE-Viewer WPF element is called up, the display of the respective 
configuration page is empty. 

Note: This also applies if, in zenon Runtime, there is a switch from one screen to another screen with 
the screen switching function. 

 

COMTRADE VIEWER CONFIGURATION 

The COMTRADE Viewer Configuration switching, arranged vertically on the side, switches the display of 
the configuration to graphic view and vice versa.  

SELECT FILE 

The Open... button opens the file selection dialog to select a file.  

There is a pre-selection for display in the file selection:  

 In doing so, file pairs of *.cfg- and *.dat files are detected.  
Note: Optional *.hdr or *.inf files are not taken into account. 

 Only the corresponding *.dat files are displayed.  

 All attendant files (*.dat, *.cfg) are loaded by clicking on the desired file and the OK button.  

 One file can be loaded. 

 After loading the file, the content of the file is shown in the Analog Channels and Digital Channels 
columns. 
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The labels and units of the elements originate from the COMTRADE configuration and cannot be 
changed. 

ANALOG CHANNELS 

Parameters Description 

[Liste der verfügbaren Kanäle] 

 

Selection of the elements to be visualized. 

Multiple selection by clicking on the desired entry in the 
list. Selected elements are shown with a colored 
background. Another mouse click undoes the selection of 
the entry.  

Select All Selects all elements from the list. 

Deselect All Deactivates the existing selection of elements. 

DIGITAL CHANNELS 

Parameters Description 

[Liste der verfügbaren Kanäle] Selection of the elements to be visualized 

Multiple selection by clicking on the desired entry in the 
list. Selected elements are shown with a colored 
background. Another mouse click undoes the selection of 
the entry. 

Select All Selects all elements from the list. 

Deselect All Deactivates the existing selection of elements. 

SHOW SELECTION 

To show your selection in the graphic view, click on the Apply button. 

Note: Clicking on the vertically-arranged COMTRADE Viewer Configuration switching only changes the 
view. An amended selection of the channels is not taken into account in the process. 
 

Runtime view - visualization of COMTRADE data 

The selected channels are visualized in the graph view of the COMTRADE-Viewer WPF element. The 
coloring can be configured in the zenon Editor. 

EXPORT OF THE SELECTED DATA 

The selected analog and digital channels can be exported to a CSV file with the CSV-Export button. 
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GRAPH VIEW  

The graph view of the COMTRADE-Viewers is divided into three sections: 

 Current amperage  
Upper area 

 Voltage  
Mid area 

 Digital channels  
Lower area 

 

AXIS LABELING 

 Horizontal axis 
The horizontal axis represents the complete time period as illustrated in the COMTRADE file 
(*.dat). 
The scaling of this time axis depends on the enlargement level. The higher the enlargement 
selected, the more detailed the time display. 

 Vertical axis 
The vertical axis represents the values.  

 The scaling of the value axis depends on the enlargement level. The greater the 
enlargement selected, the more detailed the display of values. 

 The labeling of the analog channels is shown vertically next to the values and corresponds to 
the measuring unit as defined in the COMTRADE file (*.cfg). 
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 The digital channels are displayed in the sequence as defined in the COMTRADE file 
(*.cfg). 
The Channel identifier of the COMTRADE file serves as an identifier. 

KEY 

 

The color key of the graphs is shown at the head of the graph.  

 The labeling of the digital channels corresponds to the channel description as defined in the 
COMTRADE file (*.cfg). 

 The colors for each channel are assigned automatically with the configured color palette.  

 The time is displayed in a footer under the graph. The start time is displayed as a text. 

NAVIGATION AND ZOOM 

Navigation (scroll and zoom) is always applied to all three areas of the graphic display. 

 You can move the display within the horizontal time line with the scroll bar. 

 Zoom in and zoom out 

 You can zoom at the current position of the mouse pointer in the graphics view or reduce 
the enlargement. 

 The selected area is displayed by selecting a display area with the mouse button held down. 
Note: The display of the values is always amended to the selected area. As a result, this can 
lead to a flattening of the curve in the enlarged graphic view. 

 Double clicking on the scroll bar resets the enlargement. 

ANALYSIS 
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The precise values at the position of the mouse pointer are visualized with a display in value blocks. A 
crosshair offers additional visual support with the exact determination of the reading position. 
 

Configurable control properties - color display 

ENGINEERING IN THE EDITOR 

The element with the name COMTRADE.CDWPF can be configured and placed in each zenon screen 
type. 
The project configuration of Largeur [pixels] and Hauteur [pixels] of the element depend on the 
proportions. This prevents the COMTRADE-Viewer being displayed as distorted in Runtime. 

Note: When configuring the project, ensure that there is sufficient size to guarantee a clear overview. 

GRAPHICAL AMENDMENTS 

You configure the graphic design in the properties of the WPF element. 
You can find further information in the configuration of the linking (à la page 121) chapter in this 
manual. 

Possible color values: 

 Hexadecimal color values 
#RRGGBB 
Example color values: #000000 = black , #FFFFFF = white, #FF0000 = red 

 Color values by name 
Reference: https://msdn.microsoft.com/en-us/library/system.drawing.color.aspx 
(https://msdn.microsoft.com/en-us/library/system.drawing.color.aspx) 

  Conseil 

The properties for the COMTRADE-Viewer WPF element have a "z" as a starting color. Use 
name filtering for a clear display when configuring the linking. 

CONFIGURATION PAGE 

Text and background color of the configuration page. 

 

https://msdn.microsoft.com/en-us/library/system.drawing.color.aspx
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Parameters Description Value 

zConfiguratinPageTextColor Text color of the configuration page String 

zConfigurationPageBackgroundColor Background color of the configuration 
page 

String 

BUTTONS 

Text and background color of the button. 

 

Parameters Description Value 

zButtonTextColor Text color of the button String 

zButtonBackgroundColor Background color of the button String 

CHART 

Text color of the axis labeling or key and background color. 

 

Parameters Description Value 

zChartTextColor Text color of the axis labeling. String 

zChartBackgroundColor Background color of the axis labeling String 

LABEL 

Text and background color of the display of a selected cursor position.  
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Parameters Description Value 

zChartLabelTextColor Text color of the value display String 

zChartLabelBackgroundColor Background color of the value display String 

CHART 

Color palette of the graph view and the attendant keys. 

Parameters Description Value 

zChartPalette Color palette of the colors for graphs 
and keys. 

Referencing with color palette name 
(see overview). 

Default: if no color palette is 
configured, the color palette of the 
computer's operating system is used. 

String 

POSSIBLE COLOR PALETTES - OVERVIEW 
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Energy class diagram 

The energy class diagram, WPF element is available to partners of COPA-DATA and is available to these 
via the Partner Portal. 

 

A reaction matrix must be used to model an energy class diagram. This reaction matrix must be linked to 
the variable whose value is envisaged for display and distribution in energy classes. The name of the 
variable must be transferred to the "zVariableName" property.  

REACTION MATRIX FOR ENERGY CLASS DIAGRAM 

 

The linked reaction matrix must correspond to the following schematic: 

 The first status must be an area, or a "less than" definition 
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 As many different areas as desired can then be defined. 

 The last status must be an area or a "greater than" definition. 

The following is applicable for project configuration: 

1. If the first status is an area and the value of the variable comes under this area, the first status in 
the diagram is shown nevertheless. The same is applicable for the last status the other way 
round. 

2. The colors that the WPF diagram uses for the classes are the limit value colors that were defined 
in the reaction matrix. 

3. The letters for the classes are set in alphabetical order starting with "A". 

Property Description Value 

zenonFontID ID for a font from the first font list (font size is not 
taken into account)  

Integer 

zenonNumberOfDecimalPlaces Number of displayed decimal points Integer 

zenonVariableName Name of the variable to be displayed. String 

Note: Additional VSTA programming is necessary for the display of the energy class diagram in the 
zenon web client. You can find details on this in the display of WPF elements in the zenon web client (à 
la page 160). 
 

Pareto diagram 

The Pareto diagram, WPF element is available to partners of COPA-DATA and is available to these via the 
Partner Portal.  

An example of a Pareto diagram in Runtime is shown below: 
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The following settings can be made in the WPF configuration window under COPADATA-ELEMENT: 

Property Function Value 



WPF element 

 

 

150 

 

 

zenonBarColor1 Color of the first Bar Color 

(String) 

zenonBarColor2 Color of the second Bar Color 

(String) 

zenonBarColor3 Color of the third Bar Color 

(String) 

zenonBarColor4 Color of the fourth Bar Color 

(String) 

zenonBarColor5 Color of element fifth Bar Color 

(String) 

zenonBarColor6 Color of element sixth Bar Color 

(String) 

zenonBarColor7 Color of element seventh Bar Color 

(String) 

zenonBarColor8 Color of element eighth Bar Color 

(String) 

zenonBarColor9 Color of element ninth Bar Color 

(String) 

zenonBarColor10 Color of element tenth Bar Color 

(String) 

zenonColorPercentageLine Color of the percentage line (relative sum 
frequency). 

Color 

(String) 

zenonLineVisibility Visibility of the percentage line (relative sum 
frequency). 

Boolean 

zenonVariable1_Label Labeling for the 1st Bar String 

zenonVariable1_Value Value of the 1st Bar Double 

zenonVariable2_Label Labeling for the 2nd Bar String 

zenonVariable2_Value Value of the 2nd Bar Double 

zenonVariable3_Label Labeling for the 3rd Bar String 

zenonVariable3_Value Value of the 3rd Bar Double 

zenonVariable4_Label Labeling for the 4th Bar String 

zenonVariable4_Value Value of the 4th Bar Double 

zenonVariable5_Label Labeling for the 5th Bar String 

zenonVariable5_Value Value of the 5th Bar Double 

zenonVariable6_Label Labeling for the 6th Bar String 

zenonVariable6_Value Value of the 6th Bar Double 

zenonVariable7_Label Labeling for the 7th Bar String 

zenonVariable7_Value Value of the 7th Bar Double 
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zenonVariable8_Label Labeling for the 8th Bar String 

zenonVariable8_Value Value of the 8th Bar Double 

zenonVariable9_Label Labeling for the 9th Bar String 

zenonVariable9_Value Value of the 9th Bar Double 

zenonVariable10_Label Labeling for the 10th Bar String 

zenonVariable10_Value Value of the 10th Bar Double 

The following events can be used and linked to zenon functions: 

Event Function Value 

zenonBar1Click Function that is executed when the 1st bar is 
clicked on. 

Function 

zenonBar2Click Function that is executed when the 2nd bar is 
clicked on. 

Function 

zenonBar3Click Function that is executed when the 3rd bar is 
clicked on. 

Function 

zenonBar4Click Function that is executed when the 4th bar is 
clicked on. 

Function 

zenonBar5Click Function that is executed when the 5th bar is 
clicked on. 

Function 

zenonBar6Click Function that is executed when the 6th bar is 
clicked on. 

Function 

zenonBar7Click Function that is executed when the 7th bar is 
clicked on. 

Function 

zenonBar8Click Function that is executed when the 8th bar is 
clicked on. 

Function 

zenonBar9Click Function that is executed when the 9th bar is 
clicked on. 

Function 

zenonBar10Click Function that is executed when the 10th bar is 
clicked on. 

Function 
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Circular gauge control 

Property Function Value 

CurrentValue Current value which should be displayed. Double 

IsReversed Scale orientation - clockwise or anti-clockwise. Boolean 

ElementFontFamily Element font. Font 

MinValue Minimum value of the scale. Double 

MaxValue Maximum value of the scale. Double 

ScaleRadius Radius of the scale. Double 

ScaleStartAngle Angle at which the scale starts. Double 

ScaleLabelRotationMode Alignment of the scale caption. Enum: 

 None 

 Automatic 

 SurroundI
n 

 SurroundO
ut 

ScaleSweepAngle Angel area which defines the size of the scale. Double 

ScaleLabelFontSize Font size of the scale caption. Double 

ScaleLabelColor Font color of the scale caption. Color 

ScaleLabelRadius Radius on which the scale caption is orientated. Double 

ScaleValuePrecision Accuracy of the scale caption. Integer 

PointerStyle Shape of the pointer displaying the value. Enum: 

 Arrow 

 Rectangle 

 TriangleC
ap 

 Pentagon 

 Triangle 

MajorTickColor Color of main ticks on the scale. Color 

MinorTickColor Color of sub ticks on the scale. Color 

MajorTickSize Size of main ticks on the scale. Size 

MinorTickSize Size of sub ticks on the scale. Size 

MajorTicksCount Number of main ticks on the scale. Integer 

MajorTicksShape Shape/type of main ticks on the scale. Enum: 

 Rectangle 
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 Trapezoid 

 Triangle 
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MinorTicksShape Shape/type of sub ticks on the scale. Enum: 

 Rectangle 

 Trapezoid 

 Triangle 

MinorTicksCount Number of sub ticks on the scale. Integer 

PointerSize Size of the pointer. Size 

PointerCapRadius Size of the pointer fastening point. Double 

PointerBorderBrush Color of pointer border. Brush 

PointerCapStyle Shape/type of pointer fastening point. Enum: 

 BackCap 

 FrontCap 

 Screw 

PointerCapBorderBrush Color of pointer fastening point. Brush 

PointerBrush Color of pointer. Brush 

GaugeBorderBrush Color of the element border. Brush 

GaugeBackgroundBrush Color of element background. Brush 

PointerCapColorBrush Color of pointer fastening point. Brush 

GaugeMiddlePlate Radius of the element background middle plate. Double 

PointerOffset Offset of the pointer (displacement). Double 

RangeRadius Radius of the total range display. Double 

RangeThickness Thickness of the total range display. Double 

RangeStartValue Start value of the total range display. Double 

Range1EndValue End value of the 1st area and start value of the 2nd range. Double 

Range2EndValue End value of the 2nd area and start value of the 3rd range. Double 

Range3EndValue End value of the 3rd area and start value of the 4th range. Double 

Range4EndValue End value of the 4th area and start value of the 5th range. Double 

Range5EndValue End value of the 5th area and start value of the 6th range. Double 

Range6EndValue End value of the 6th range. Double 

Range1ColorBrush Color of the first range. Brush 

Range2ColorBrush Color of the second range. Brush 

Range3ColorBrush Color of the third range. Brush 

Range4ColorBrush Color of the fourth range. Brush 

Range5ColorBrush Color of element fifth range. Brush 

Range6ColorBrush Color of element sixth range. Brush 
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ScaleOuterBorderBrush Color of the scale border. Brush 

ScaleBackgroundBrush Color of scale background. Brush 

ValueTextFrameStyle Shape/type of value display. Enum: 

 LargeFram
e 

 SmallFram
e 

 None 

ValueTextContent Content of the value display. Enum: 

 Text 

 TextValue 

 Value 

ValueTextSize Font size of the value display. Double 

ValueTextColor Font size of the value display. Color 

IsGlasReflection Activate the glass effect on the element. Boolean 

GaugeOffsett Lowering the rotation point of the whole element. Double 

 
 

Sankey diagram 

The Sankey diagram, WPF element is available to partners of COPA-DATA and is available to these via 
the Partner Portal. 

The Sankey wizard must be used to model a Sankey diagram. The wizard creates an XML file that is then 
evaluated by the WPF element. To do this, the zSankeyName property must be given the name of the 

XML file. The XML file must be in the Other folder of a project. This is saved there by the wizard. 

An example of a Sankey diagram in Runtime is shown below: 

 

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT: 



WPF element 

 

 

156 

 

 

Property Function Value 

FontSize Font size of the texts. Integer 

zBackgroundColor Background color of the diagram. Color 

(String) 

zFontColor Color of the texts. Color 

(String) 

zFontFamily Font of all texts. Font 

(String) 

zLossDetectionActive Automatic loss detection activated/deactivated. If 

true, then losses are automatically shown at a 
node points as flows. 

Boolean 

zNoDataText Text that is displayed if there are no values to 

display and zPrevireActive is false. 

String 

zNoValidXMLText Text that is displayed if no valid XML file with 
entered name has been found and zPreviewActive 
is false. 

String 

zNumberOfDecimalPlaces Denotes how many decimal places are to be 
displayed. 

Integer 

zPreviewActive Display of a preview activated/deactivated.  

The preview can be displayed if  

There is no data present (the modeled diagram is 
filled with default values) or  

the XML file was not found or  

this does not contain a valid definition (an example 
Sankey diagram is displayed).  

Boolean 

zRefreshRate Rate at which the diagram is refreshed in ms. Integer 

zSankeyName Name of the XML file with the modeling of the 
diagram. 

String 

zShowRelativeValues Display of the values in absolute false or relative 

values true. 

Boolean 

Note: Additional VSTA programming is necessary for the display of the Sankey class diagram in the 
zenon web client. You can find details on this in the display of WPF elements in the zenon web client (à 
la page 160). 
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Temperature indicator - TemperatureIndicatorControl 

Property Function Value 

CurrentValue Current value which should be displayed. Double 

MinValue Minimum value of the scale. Double 

MaxValue Maximum value of the scale. Double 

MajorTicksCount Number of main ticks on the scale. Integer 

MinorTicksCount Number of sub ticks on the scale. Integer 

TickNegativColor Color of the negative main tick (gradient to 
TickPositivColor). 

Color 

TickPositivColor Color of the positive main tick (gradient to 
TickNegativColor). 

Color 

MinorTickColor Color of the sub ticks. Color 

ElementBorderBrush Color of the element border. Brush 

ElementBackgroundBrush Color of element background. Brush 

ElementGlasReflection Activate the glass effect on the element. Visibility 

ElementFontFamily Element font. Font 

IndicatorColor Color of the indicator fill color. Color 

IndicatorBorderColor Color of the indicator border. Color 

MajorTickSize Size of main ticks on the scale. Size 

MinorTickSize Size of sub ticks on the scale. Size 

ScaleLetteringDistance Distance of the scale caption (vertical), each x. main tick 
should be captioned. 

Integer 

IndicatorScaleDistance Distance between indicator and scale (horizontal). Double 

ScaleFontSize Font size of the scale. Double 

ScaleFontColor Font color of the scale. Color 

Unit Unit. String 

ElementStyle Shape/type of element. Enum: 

 SmallFram
e 

 Unit 

 None 

 
 



WPF element 

 

 

158 

 

 

Universal slider - UniversalReglerControl 

Property Function Value 

CurrentValue Current value which should be displayed. Double 

ElementFontFamily Element font. Font 

MinValue Minimum value of the scale. Double 

MaxValue Maximum value of the scale. Double 

Radius  Double 

ScaleRadius Radius of the scale. Double 

ScaleStartAngle Angle at which the scale starts. Double 

ScaleLabelRotationMode Alignment of the scale caption. Enum: 

 None 

 Automatic 

 SurroundIn 

 SurroundOu
t 

ScaleSweepAngle Angel area which defines the size of the scale. Double 

ScaleLabelFontSize Font size of the scale caption. Double 

ScaleLabelColor Font color of the scale caption. Color 

ScaleLabelRadius Radius on which the scale caption is orientated. Double 

ScaleValuePrecision Accuracy of the scale caption. Integer 

ElementStyle Display type of the element Enum: 

 Knob 

 Plate 

 None 

MajorTickColor Color of main ticks on the scale. Color 

MinorTickColor Color of sub ticks on the scale. Color 

MajorTickSize Size of main ticks on the scale. Size 

MinorTickSize Size of sub ticks on the scale. Size 

MajorTicksCount Number of main ticks on the scale. Integer 

MajorTicksShape Shape/type of main ticks on the scale. Enum: 

 Rectangle 

 Trapezoid 

 Triangle 
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MinorTicksShape Shape/type of sub ticks on the scale. Enum: 

 Rectangle 

 Trapezoid 

 Triangle 

MinorTicksCount Number of sub ticks on the scale. Integer 

BackgroundBorderBrush Color of the element border. Brush 

BackgroundBrush Color of element background. Brush 

PointerCapColorBrush Color of pointer fastening point. Brush 

GaugeMiddlePlate Radius of the element background middle plate. Double 

ValueFontSize Font size of the value display. Double 

ValueFontColor Font size of the value display. Color 

IsGlasReflection Activate the glass effect on the element. Boolean 

KnobBrush Color of the knob. Brush 

IndicatorBrush Color of the indicator. Brush 

IndicatorBackgroundBrush Background color of the inactive indicator. Brush 

KnobSize Diameter of the knob. Double 

KnobIndicatorSize Indicator size of the knob. Size 

ElementSize Size of the element. Size 

VisibilityKnob Activating of the knob. Boolean 

ValuePosition Position of the value display. Double 

ValueVisibility Activating the value display. Boolean 

 
 

Waterfall diagram 

The waterfall diagram, WPF element is available to partners of COPA-DATA and is available to these via 
the Partner Portal. 

The meaning and waterfall chart wizard must be used to model a waterfall diagram. A waterfall can be 
modeled with this wizard. The information is saved directly for the variables concerned in the Analyzer 
--> Parameters for waterfall diagram. 
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An example of a waterfall diagram in Runtime is shown below: 

 

Note: This screenshot is only available in English. 

The following settings can be made in the WPF configuration window under COPADATA-ELEMENT: 

Property Function Value 

zenonRefreshRate Time between the refreshes of the 
diagram in ms. 

Integer 

zenonWaterfallIdentifier Name of the waterfall diagram. String 

zenonZSystemModel Equipment group of the variables 
used. 

String 

Note: Additional VSTA programming is necessary for the display of the waterfall diagram in the zenon 
web client. You can find details on this in the display of WPF elements in the zenon web client (à la page 
160). 

 
 

6.4.6 Display of WPF elements in the zenon web client 

In order to also be able to also use the pre-made WPF elements "energy class diagram", "Sankey 

diagram" and "waterfall chart" for the display in a zenon web client, amendments are necessary in the 
project: 

 Engineering in the zenon Editor (à la page 161) 

 Adapt VSTA code (à la page 161)  
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Engineering in the zenon Editor 

Carry out the following project configuration steps in the zenon Editor, in order to also be able to display 
certain WPF elements in the zenon web client: 

PLACE WPF IN THE ZEN ON SCREEN: 

 Place the WPF element in a zenon screen. 

 Give it a unique name in the Nom d'élément property. 
You can find this property in the Général properties group. 
Note: A warning dialog appears if the name for an element has already been issued in another 
screen. 

 Use the element name issued here in the VSTA code. 

 
 

VSTA code (complex) 

In order to add the programmer code for the display of WPF elements in the zenon web client, carry out 
the following steps: 

1. In the zenon Editor, switch to the programmer interfaces node. 

2. Select the VSTA node and select the Open VSTA Editor with project add-in... with a right mouse 
click 

3. The dialog to create a VSTA project is opened. 

4. Select the C# entry in the Create new VSTA project dialog. 

5. Create (copy) the code below. 

6. Enter the name of the WPF element in the code. 

 
Note: When opening the VSTA editor, note whether the content of the following code is already present 
in the project configuration. For the display of the WPF element in the web client, compare the existing 
code and undertake the necessary additions. Please note the comments in relation to this in the model 
code. 

VSTA CODE 

//As member: 

zenOn.IDynPictures zScreens = null; 

string[] WPFElements ={"WPF_Control", "WPFWebclient_1", "WPFWebclient_2" }; //Names of the 

WPF screen elements that appear in the zenon project and that need access to the API (as 

many/few as you want) 
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//Add the following three lines of code in the project archive function: 

void ThisProject_Active() 

{ 

  zScreens = this.DynPictures(); 

  zScreens.Open += new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open); 

  zScreens.Close += new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close); 

} 

//Add the following two lines of code in the project inactive function: 

void ThisProject_Inactive() 

{  

  zScreens.Open -= new zenOn.DDynPicturesEvents_OpenEventHandler(zScreens_Open); 

  zScreens.Close -= new zenOn.DDynPicturesEvents_CloseEventHandler(zScreens_Close); 

   

  //Final release and garbage collection of any API-Objects. 

  FreeObjects(); 

} 

 

//Add two new event handlers: 

void zScreens_Open(zenOn.IDynPicture obDynPicture) 

{ 

  foreach (string element in WPFElements) 

  { 

    if (obDynPicture.Elements().Item(element) != null) 

    { 

 obDynPicture.Elements().Item(element).set_WPFProperty("ELEMENT", 

"zenonVariableLink", this.Variables().Item(0)); 

    } 

  } 

} 

void zScreens_Close(zenOn.IDynPicture obDynPicture) 

{ 

  foreach (string element in WPFElements) 

  { 

    if (obDynPicture.Elements().Item(element) != null) 

    { 

 zenOn.IElement zWPFElement= obDynPicture.Elements().Item(element); 

 zWPFElement.set_WPFProperty("ELEMENT", "zenonTrigger", true); 

 zWPFElement = null; 
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    } 

  } 

} 
 

VSTA code (simplified) 

If only one WPF element is used in a zenon screen, the following more streamlined code can be used as 
an alternative. To do this, the names of the WPF element, and the screen in which the element is used, 
must be entered. This code is then recommended if, for each project, only one of the pre-made WPF 
elements is used. 

VSTA CODE 

zenOn.IDynPicture zScreen = zero; 

string wpfElement = "WPF_Control"; //Name of the WPF element in the screen 

string wpfPicture = "@Details_Overview_Online"; //Name of the zenon screen 

 

//Add to the project active function: 

void ThisProject_Active() 

{ 

  zScreen = this.DynPictures().Item(wpfPicture); 

  zScreen.Open += new zenOn.OpenEventHandler(zScreen_Open); 

  zScreen.Close += new zenOn.CloseEventHandler(zScreen_Close); 

} 

 

//Add to the project inactive function: 

void ThisProject_Inactive() 

{ 

  zScreen.Open -= new zenOn.OpenEventHandler(zScreen_Open); 

  zScreen.Close -= new zenOn.CloseEventHandler(zScreen_Close); 

 

  //Final release and garbage collection of any API-Objects. 

  FreeObjects(); 

} 

 

void zScreen_Open() 

{ 

  if (zScreen.Elements().Item(wpfElement) != null) 

  {               
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 zScreen.Elements().Item(wpfElement).set_WPFProperty("ELEMENT", 

"zenonVariableLink", this.Variables().Item(0)); 

  } 

} 

         

void zScreen_Close() 

{ 

  if (zScreen.Elements().Item(wpfElement) != null) 

  { 

 zenOn.IElement zWPFElement = zScreen.Elements().Item(wpfElement); 

 zWPFElement.set_WPFProperty("ELEMENT", "zenonTrigger", true); 

 zWPFElement = null; 

  } 

} 

 
 

6.4.7 Examples: Integration of WPF in zenon 

You can see how XAML files are created and integrated as WPF elements in zenon from the following 
examples: 

 Integrate button as WPF XAML in zenon (à la page 170) 

 Integrate bar graph as WPF XAML in zenon (à la page 164) 

 Integrate DataGrid Control in zenon (à la page 176) 

 
 

Integrate bar graph as WPF XAML in zenon 

Example structure: 

 Creating a bar graph (à la page 88) in Adobe Illustrator and converting it to WPF 

 Integrate into zenon 

 Linking with variables 

 Adapting the bar graph WPF element 
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CREATE BAR GRAPH 

The first step is to generate a bar graph as described in the Workflow with Adobe Illustrator (à la page 
88) chapter. To be able to use the XAML file in zenon, insert this in the project tree in the Files/graphics 

folder. 

INTEGRATE BAR GRAPH 

Note: A zenon project with the following content is used for the following description: 

 An empty screen as a start screen 

 Four variables from the internal driver for 

 Scale 0 

 Scale central 

 Scale high  

 Current value 

 A variable from the mathematics driver for displaying the current value (255) 

To integrate the bar graph: 

1. open the empty screen 

2. place a WPF element (à la page 120) in the screen 

3. select Fichier XAML in the properties window 

4. Select the desired XAML file (for example bar graph_vertical.xaml) and close the dialog 
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ADJUST BAR GRAPH 

Before configuration, the scale of the XAML file is adapted if necessary: 

 

To do this: 

 Create a new mathematics variable that calculates the new value in relation to the scaling, 
for example: 

 Variable: 0-1000 
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 Mathematic variable {value created in xaml file}*Variable/1000 

 

The XAML file is then configured. 

CONFIGURE BAR GRAPH 

1. Click on the WPF element and select the Configuration property 

2. The configuration dialog shows a preview of the selected XAML file. 
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3. Select the minimum value, the average value and the maximum value and link each of these to 
the corresponding variable in the Content property 
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4. Select the Slider and link the Value property to the mathematics variables (in our example: 

calculation)  

5. Check the project planning in Runtime: 
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Integrate button as WPF XAML in zenon 

Example structure: 

 Creating a button (à la page 85) in Microsoft Expression Blend 

 Integrate into zenon 

 Link to a variable and a function 

 adjust the button to the size of the element 

 Create button 

As a first step, create a button as described in the Create button as XAML file with Microsoft Expression 
Blend (à la page 85) chapter. To be able to use the XAML file in zenon, insert this in the project tree in 
the Files/graphics folder. 

INTEGRATE BUTTON 

Note: A zenon project with the following content is used for the following description: 

 An empty screen as a start screen 

 an internal variable int of type Int 

 a function Funktion_0 of typeSend value to hardware with: 

 Direct to hardware option activated 

 Set was set to 45 

To integrate the button: 

1. open the empty screen 

2. place a WPF element (à la page 120) in the screen 

3. select Fichier XAML in the properties window 

4. select the XAML file (e. g.  MyButton.xaml and close the dialog 

5. select the Configuration property 
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CONFIGURE THE BUTTON 

The configuration dialog shows a preview of the selected XAML file. All elements named in the XAML file 
are listed in the tree: 

 

1. select the WPF button, which is in LayoutRoot->MyViewBox->MyButton 

2. Look in the Properties EntryContent tab; this contains the button's text 

3. Click the Link type column 

4. Select Variable from the drop down list 

5. Click in the Link column 

6. the variable selection dialog is opened 

7. select the int variable to link this variable with the Content property 

EVENTS 

To also assign events: 
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1. select the events tab 

 

2. look for the 'Click' entry, this event is triggered by the WPF element, as soon as the button is 
clicked 

3. Click in the Link type column 

4. Select Function from the drop down list 

5. Click in the Link column 

6. the function selection dialog is opened  

7. select Function_0 

8. Confirm the changes with OK  

9. Insert a numerical value element into the screen 

10. Link this numerical value element to the int variables too. 

11. Compile the Runtime files and start Runtime. 
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The WPF element is displayed in Runtime, the button text is 0. As soon as you click on the button, the 
click event is triggered and the set value function is carried out. The value 45 is sent directly to the 
hardware and both numerical value and button display the value 45 . 

 

Define a set value of 30 via the numerical value element; this value is then also assumed by the WPF 

element. 

AUTHORIZATION 

Similar to a numerical value,  a WPF element can be locked according to authorizations (lock symbol) or 
switched to be operable. Set the user authorization level to 1 for the WPF element and create a user 
called Test with authorization level 1. In addition, set up the functions Login with dialog and Logout .  
You link these two functions with 2 new text buttons on the screen. 

In the WPF element configuration dialog, select the MyButton WPF button and select the Properties: tab 
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1. Select the IsEnabled element 

2. Click in the Link type column 

3. Select Authorizations/interlocking from the drop down list 

4. Click in the Link column 

5. In the drop-down list, select the Authorized option  

 

6. Close the dialog with OK  

Compile the Runtime file and note that Authorizations to be Transferred must also be selected. After 
Runtime has been started, the WPF button is displayed as deactivated on the screen and cannot be 
operated. If you now log in as the user Test, the button is activated and can be operated. The button is 
locked again as soon as you log out. 

 

TRANSFORMATION 

The XAML files must still be adapted to use transformations: 

1. switch to the Expression Blend  program 

2. select MyButton, so that the properties of the element are visible in the events window 

 

3. Under Transform at RenderTransform select the Apply relative transform option 
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As a result of this, a block is inserted into the XAML file, which save the transformation settings 
in runtime. 

 

4. Save the file and replace the old version in zenon with this new file. 

5. Open the WPF element configuration dialog again: 

a) select the MyButton button  

b) select the Transformations tab 

 

c) select the RotateTransform.Angle element 

d) Click in the Link type column    

e) Select Transformations from the drop down list 

f) Click in the Link column  

g) the variable selection dialog is opened  

h) select the int variable to link this variable with the RotateTransform.Angle property 
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Compile the Runtime files and start Runtime. Log in as the Test user and click on the button. The button 
has the value 45 and the WPF element rotates by 45°. 

 
 

Integrate DataGrid Control in zenon 

To create DataGrid control for zenon, you need: 

 Visual Studio (Visual Studio 2015 in this example) 

CREATE WPF USER CONTROL 

1. in Visual Studio, create a new Solution and a WPF User Control Library project in .NET 
Framework version 4 or higher therein. 

Info: If the corresponding project template does not appear in the list of available templates, 
this can be added by means of the search (field at the top right of the dialog). 
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In our example, the project is given the name DataGridControlLibrary. 

2. Create a new data connection in the Server Explorer.  

In our example, the database Northwind is used, which is provided by Microsoft as an example 
database that can be downloaded for free.  

Te set up the database connection: 

a) Right-click on Data Connections. 

b) Select Add connection…. 

c) Select Microsoft SQL Server (SQLClient) as Data source. 

d) Select the corresponding server and database name. 
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After adding the connection, the Server Explorer window should look a little like this: 

 

A new DataSet is created in the next step. 

CREATING A DATASET 

1. Right-click on the project 

2. Select Add – New Item… in the context menu 

3. Create a new DataSet  with the name DataSet1. 

4. Double click on the DataSet in order to open it in the Designer. 

5. Drag the tables that you need (Customers and Orders in this example) to the DataSet design 
window. 

 

The XAML file is modified in the next step. 



WPF element 

 

 

179 

 

 

CONFIGURATION OF THE XAML FILE 

1. If not already there, add the Namespace as a reference to the class in the XAML file: 

 

2. Define the resources and the DataGrid that is to be used in the WPF: 

<UserControl.Resources> 

<local:DataSet1 x:Key="DataSet1"/>  

<CollectionViewSource x:Key="CustomersViewSource" Source="{Binding Path=Customers, 
Source={StaticResource DataSet1}}"/>  

</UserControl.Resources>  

<Grid DataContext="{StaticResource CustomersViewSource}">  

<DataGrid Name="DataGrid1" DisplayMemberPath="CompanyName" 
ItemsSource="{Binding}" SelectedValuePath="CustomerID" 
HorizontalAlignment="Stretch" VerticalAlignment="Stretch"/>  

</Grid>  

3. Open the code-behind file (UserControl1.xaml.cs) and insert the following lines in the 
constructor: 

public UserControl1()  

{ 

InitializeComponent();  

DataSet1 ds = ((DataSet1)(FindResource("DataSet1")));  

DataSet1TableAdapters.CustomersTableAdapter ta = new 
DataSet1TableAdapters.CustomersTableAdapter();  

ta.Fill(ds.Customers);  

CollectionViewSource CustomersViewSource = 
((CollectionViewSource)(this.FindResource("CustomersViewSource")));  

CustomersViewSource.View.MoveCurrentToFirst();  

} 

In doing so, the following happens: 

 The DataSet is obtained 

 A new TableAdapter is created 

 The DataSet is filled 
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 The information is provided to the DataGrid control 

The solution can now be built. 

BUILD 

Now build the solution. The corresponding DLL (DataGridControlLibrary.dll) is created in the output 
folder of the project.  

Now you have a DLL with the necessary functionality available. 

However zenon can only display XAML files that cannot be linked to the code behind file, which is why 
an additional XAML file is needed that references the DLL that has just been created.  

To do this: 

1. Create a further project, again as a WPF User Control Library  

2. It was called DataGridControl in our example. 

3. Insert a reference to the project that has just been built into this new project. 

 

4. The XAML files (UserControl1.xaml) looks as follows: 

 

5. Because all necessary content is contained in the DLL that has been created and no code-behind 
is necessary, delete the following lines: 

x:Class="DataGridControl.UserControl1" 

xmlns:local="clr-namespace:DataGridControl" 

6. Also delete (for the positioning) the following lines: 

mc:Ignorable="d"  

d:DesignHeight="300" d:DesignWidth="300" 
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7. Delete the code-behind file (UserControl1.xaml.cs) in this project. 

8. Define what is to be displayed in the XAML file.  

To do this, modify the XAML file as follows: 

<UserControl xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"  

xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"  

xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"  

xmlns:d="http://schemas.microsoft.com/expression/blend/2008"  

xmlns:dataGridLibrary="clr-namespace:DataGridControlLibrary;assembly=DataGridCo
ntrolLibrary">  

<Grid x:Name="Grid1">  

<dataGridLibrary:UserControl1 Name="DataGridControl" HorizontalAlignment="Left" 
VerticalAlignment="Top"/>  

</Grid>  

</UserControl> 

The 
linexmlns:dataGridLibrary="clr-namespace:DataGridControlLibrary;assembly=DataGrid
ControlLibrary" defines the namespace dataGridLibrary and stipulates that this should use 
the assembly that has been created. 

9. Assign a name for the grid. 

10. Insert the control dataGridLibrary:UserControl1 from our library and give it a name, because 
zenon can only modify objects that have a name.  

11. Build the solution.  
 

In the next step, how the DLL and XAML file are added to zenon is explained. 

STEPS IN ZENON 

1. Open the zenon Editor 

2. Go to File -> Graphics. 

3. Select Add file... in the context menu 
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4. Select the XAML file at the save location (UserControl1.xaml from the DataGridControl project) 
and add this: 

 

5. Insert the DLL with the functionality for the XAML file.  

To do this: 

a) Select, in the context menu, File -> OtherAdd file.... 

b) Select the file DataGridControlLibrary.dll of the first project (DataGridControlLibrary). 

 

6. Create a  zenon screen. 

7. Add a WPF element and select the previously-incorporated XAML file.  

You should now see the following in the zenon Editor: 

 

8. Start zenon Runtime in order to also test the control there. 

  Attention 

Assemblies are only removed after loading when the application is ended. This means:  

If a WPF file with a referenced assembly in zenon is displayed, then this assembly is 
loaded is in the memory until zenon is ended, even if the screen is closed again. If you 

would like to remove an assembly from the Files/Other folder, the Editor must first 
be restarted, so that the assembly is removed.  
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6.4.8 Error handling 

ENTRIES IN LOG FILES 

Entry  Level Meaning 

Xaml file found in %s 

with different name, 

using default! 

Warning The name of the collective file and the name of the XAML file 
contained therein do not correspond. To avoid internal conflicts, the 
file with the name of the collective file and the suffix .xaml is used. 

no preview image 

found in %s 
Warning The collective file does not contain a valid preview graphic 

(preview.png or [names of the XAML file].png). Thus no 
preview can be displayed. 

Xaml file in %s not 

found or not unique! 
Error The collective file does not contain an XAML file or several files with 

the suffix .xaml. It cannot be used. 

Could not remove old 

assembly %s 
Warning There is an assembly that is to be replaced with a newer version, but 

cannot be deleted. 

Could not copy new 

assembly %s 
Error A new version is available for an assembly in the work folder, but it 

cannot be copied there. Possible reason: The old example is still 
loaded, for example. The old version continues to be used, the new 
version cannot be used, 

file exception in %s Error A file error occurred when accessing a collective file. 

Generic exception in 

%s 
Error A general error occurred when accessing a collective file. 
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